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INLEIDING

Deze beginnershandleiding (“tutorial”) is bedoeld om gebruikers snel op weg te helpen met
het gebruik van MicroFEM. Er wordt gebruik gemaakt van een stapsgewijze instructie voor
het oplossen van een relatief simpel grondwaterprobleem met MicroFEM versie 4.10.00 of
later.

Zaken die worden behandeld betreffen o.a.:

e Hoe een eindige-elementen netwerk kan worden gemaakt met MicroFEM

o Hoe hydraulische parameters (“grondconstanten” als doorlaatvermogen, verticale hydraulische
weerstand) kunnen worden ingevoerd

e Hoe randvoorwaarden dienen te worden ingevoerd (aanvulling door neerslag, open
modelranden versus ondoorlatende modelranden; grondwateronttrekkingen; freatisch versus
spanningsgrondwater)

e Hoe snel een visuele controle kan worden uitgevoerd op randvoorwaarden en ingevoerde

parameters

Hoe de stroming in het model stationair of niet-stationair kan worden doorgerekend

Hoe tijdsafhankelijke grondwaterstroming kan worden gemodelleerd met MicroFEM

Hoe grafische resultaten snel kunnen worden verkregen (isolijnenkaarten; stroomvectoren)

Hoe resultaten in tekst- of tabelvorm kunnen worden gegenereerd (waterbalansen)

Hoe meer geavanceerde grafische uitvoer kan worden gemaakt (tijd-stijghoogtelijnen;

stijghoogteprofielen; 3D-stroomlijnen)

e En hoe MicroFEM naar persoonlijke voorkeur kan worden ingesteld.

En passant zullen vrijwel alle menu-opdrachten en knoppen van MicroFEM’s grafische
gebruikersinterface (GUI — spreek uit als “goewie”) worden gebruikt. Ook enkele trucs om
snel en efficiént sommige taken uit te voeren passeren de revue.

Vrijwel alle knoppen hebben een overeenkomende menu-opdracht en omgekeerd;
bovendien hebben vele knoppen/menu-opdrachten toetsenbord-equivalenten. In de tekst
zullen al deze mogelijkheden elk minimaal één keer worden gebruikt. De nadruk ligt echter
op het gebruik van een muis.

Zaken die niet zullen worden behandeld betreffen o.a.:

o De wiskundige achtergrond van de eindige elementen methode (en andere wiskundige
modelprocedures)

e Basaal inzicht in hoe grondwatermodellen Gberhaupt werken en kunnen worden gebruikt

o Basale kennis van het Windows besturingssysteem (muis, “focus”, menu’s, knoppen, etc)

o De talrijke manieren waarop een hydrologisch probleem z6 kan worden omgezet dat het
als model in de computer kan worden ingevoerd

¢ De minstens zo talrijke manieren waarop uitvoer van een grondwatermodel kan worden
geinterpreteerd en vertaald naar praktisch uitvoerbare oplossingen voor het eigenlijke
probleem

¢ Relatief ingewikkelde bovenrandvoorwaarden zoals drains, wadi’s, evapotranspiratie, en
relatief complexe interne randvoorwaarden (ondoorlatende interne grenzen, open-
waterlichamen, etc) of andere geavanceerde onderwerpen (bijv. meerlagen-systemen,
tijdsafhankelijke grondwaterbalansen, flux-functies).

o Kalibratie van het gepresenteerde model, of van welk model dan ook

e Koppelingen tussen MicroFEM en andere software (GIS; voor- of nabewerking van grafische
uitvoer; etc).

Al met al is deze handleiding primair bedoeld om grondwaterhydrologen die modelleer-

ervaring hebben met andere MS-Windows programma’s op gang te helpen met MicroFEM.
Voor meer geavanceerde onderwerpen wordt verwezen naar de On-line beschikbare
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MicroFEM Help bestanden, waarin een aanzienlijke hoeveelheid informatie is opgenomen.
Mocht dit ook niet helpen, dan kan men eventueel contact opnemen met de support-desk
(support@microfem.nl)

Deze handleiding is zo opgezet dat de gratis probeerversie van MicroFEM kan worden
gebruikt (www.microfem.nl). Deze versie heeft -afgezien van de beperking tot 2 water-
voerende pakketten en 2500 knooppunten- dezelfde functionaliteit als de volledige versie.

Tenslotte: Deze Nederlandse beginnershandleiding is een (geactualiseerde) vertaling van de
oorspronkelijke Engelstalige tutorial. Nu is het zo dat in de wereld van grondwatermodellen
Nederlandse en Engelse terminologie vrij losjes door elkaar wordt gebruikt. Dit geldt in nog
veel sterkere mate voor het gebruik van computers zelf. Er is getracht om in deze beginners-
handleiding voor zoveel mogelijk Engelse termen een Nederlands equivalent te vinden, maar
we weten heel goed dat dit af en toe “gedwongen” overkomt. Laat u zich hierdoor niet
afleiden van waar het feitelijk om gaat, namelijk dat u als beginnend MicroFEM gebruiker
snel aan de slag kunt.
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HET VOORBEELDPROBLEEM

Deze beginnershandleiding laat zien hoe MicroFEM kan worden gebruikt om uitkomsten te
genereren voor een -in dit geval- verzonnen situatie. Dit voorbeeldprobleem is geleend van
Belgische collega’s’ en is regelmatig gebruikt in een driedaagse MicroFEM-cursus.

De situatie betreft een rechthoekig gebied waarin een freatische grondwaterspiegel voorkomt
en waarin het grondwater alleen uit het neerslagoverschot wordt gevoed. Een
grondwaterwinning in het centrale modelgebied wordt mogelijk bedreigd door verontreinigd
lekwater uit een naburige vuilstort.

Het modelgebied meet 10.000 (oost-west) bij 6000 meter (noord-zuid). De vuilstort ligt 2000
m ten zuiden van de noordgrens en 2000 m westelijk van de grondwaterwinning. Deze
winning ligt 1000 m zuidelijk van het midden van het modelgebied (Figuur 1).
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Figuur 1: Overzicht van het modelgebied

In het modelgebied komt een watervoerend pakket voor dat bestaat uit zandige afzettingen
met een homogene en isotrope doorlatendheid van 12 m/dag, een effectieve porositeit van
0,35 en een opbrengstcoéfficiént van 0,2. Onder het watervoerend pakket ligt een dikke
kleilaag die als ondoorlatend kan worden beschouwd.

Het grondwater wordt gevoed uit een neerslagoverschot van 240 mm/jaar; rechte rivieren (of
kanalen) liggen langs de noord- en zuidgrens. In deze handleiding worden deze rivieren
geacht volledig (d.w.z. tot de basis van het pakket) ingesneden te zijn en een
verwaarloosbare in- en uittreeweerstand te hebben. De vaste rivierpeilen (niet beinvioed
door de grondwaterstroming) reiken tot 35 m boven de basis van het watervoerend pakket
(Figuur 2).

Omdat zonder de grondwaterwinning de grondwaterstroming precies naar het noorden of
zuiden zou zijn, mogen de west- en oostrand van het model als volledig ondoorlatend
worden beschouwd (ze liggen namelijk langs een stroomlijn). Deze aanname klopt niet
precies wanneer grondwater in de put wordt gewonnen, maar de afstand tussen deze randen
en de put (minimaal 5000 m) wordt in dit geval groot genoeg geacht om de hierbij
optredende randstroming te kunnen verwaarlozen.

! Viaene, P., C. Vlieghe, J. Bellon, M. Buysse and P. de Smedt (1996) Beschrijving van vier

softwarepakketten voor grondwatermodellering. Water (90) p. 235-240
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Figuur 2: Noord-zuid doorsnede van het modelgebied

We zullen beginnen met het modelleren van de grondwaterstroming die het gevolg is van de
voeding uit het neerslagoverschot. Daarna wordt het model stapsgewijs ingewikkelder
gemaakt door het inbrengen van de grondwateronttrekking en door de grondwaterstroming,
die eerst stationair is, tijdsafhankelijk (niet-stationair) te maken.

Nadat we eerst MicroFEM hebben geinstalleerd zal dit probleem opgelost worden in de

volgende stappen:

1. Het maken van een eindige-elementen netwerk.

2. Toekennen van namen (“labels”) aan bepaalde (groepjes) knooppunten.

Invoeren van de grondconstanten (met behulp van labels) en dit interactief controleren
Invoeren van randvoorwaarden (voeding, vaste stijghoogtes, putonttrekking) met behulp van
labels en dit interactief controleren.

3. Berekenen van de grondwaterstroming zonder putonttrekking en analyseren van enkele
basale resultaten (isohypsen, stroomvectoren, stijghoogteprofielen, dwarsdoorsneden, 3D-
plaatjes, waterbalansen).

4. Berekenen van de grondwaterstroming met de putonttrekking en analyseren van
soortgelijke resultaten als in stap 3.

5. Berekenen van het verschil tussen de situaties van stappen 3 en 4, hetgeen feitelijk de
invloed van alleen de putonttrekking laat zien.

6. Het gebruik van 3D-stroomlijnen om het intrekgebied van de putonttrekking te
achterhalen.

7. Niet-stationaire berekeningen en het visualiseren van de tijdsafhankelijke effecten van de
putonttrekking (isohypsen, tijd-stijghoogtelijnen).
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INSTALLEREN EN OPSTARTEN VAN MICROFEM

Installeren van MicroFEM voor Windows (demo versie)

De installatieprocedure is hetzelfde al voor de meeste andere software die onder Windows
wordt gebruikt:

1. Download het programma van het Internet (http://www.microfem.nl/)

2. Pak het setup-programma uit met behulp van uw favoriete in/uitpakprogramma (WinZip,
PowerArchiver, 7-Zip, etc.) en sla het ergens (tijdelijk) op.

Dubbelklik op het setup-programma en volg de instructies.

Klaar! Er kan nu met MicroFEM worden gewerkt.

P w

De MicroFEM bestandsextensies (.FEN, .FEM, .FPR) worden automatisch aan MicroFEM gekoppeld. MicroFEM
kan dan worden gestart door dubbelklikken op een MicroFEM netwerk-, model- of projectbestand.

Starten van MicroFEM en de MicroFEM GUI

Opstarten van MicroFEM is simpel: dubbelklik op het MicroFEM-icoon op het bureaublad of
gebruik het Start Menu van Windows. Nadat gedurende korte tijd een MicroFEM beeldmerk
schermpje wordt getoond (met logo, naam en versienummer) wordt vervolgens het volgende
venster geopend (Figuur 3):

JST=I
Files Project Wiew Commands Calculate Options Tools Import Export  Help
Paraml
| | |
] e e .8 10 e | < e o A ala) Ele| s @l

Figuur 3: Leeg MicroFEM venster

Waarschijnlijk is de achtergrondkleur van het MicroFEM-venster zwart. Hieronder wordt
aangegeven hoe dat kan worden veranderd naar bijvoorbeeld wit.

Alle knoppen op de werkbalk onderaan zijn grijs en niet aanklikbaar, omdat ze nog geen
functie hebben zolang er geen netwerk of model is geladen. Bij proberen van de pull-down
menu’s van de hoofdmenubalk zal blijken dat ook hier de meeste opdrachten grijs zijn.
Enkele belangrijke uitzonderingen hierop betreffen:

= Help > Help F1 zal het MicroFEM On-line Help-venster openen.
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= Help = Info > About MicroFEM. Klikken op deze opdracht doet het MicroFEM
beeldmerk schermpje opnieuw verschijnen (bijv. ter controle van het versienummer).

= Options. Hiermee kan een aantal belangrijke instellingen worden aangepast, zoals
eenheden (meters of voeten;zorg voor wat betreft deze Tutorial dat hier “meters” staat ingesteld)
en een aantal persoonlijke voorkeuren zoals kleuren. Deze instellingen kunnen voor later
gebruik van MicroFEM worden bewaard met behulp van Options - Save settings. Een in
sporadisch optredende gevallen (zoals traag rekenen) handige opdracht is "Memory", (zie
de On-line help via de "Help"-knop).

= Tools = Time curves. Voor het visualiseren van de informatie in MicroFEM’s eigen
tijdstijghoogte-bestanden (die later zullen worden behandeld) is het niet noodzakelijk om een
model te hebben geladen, daarom is deze opdracht altijd beschikbaar.

= Calculate > Edit batch-file. Ook hier geldt dat er geen model hoeft te zijn geladen om
MicroFEM'’s batchfile te kunnen bewerken, omdat die batchfiles als gewone ASCII
tekstbestanden worden behandeld.

Meestal start MicroFEM de eerste keer op in een klein venster. Het is beter om dit venster te
maximaliseren of met de muis te vergroten tot een redelijk groot formaat. Een minimum
grootte van 720 pixels is benodigd voor het weergeven en kunnen gebruiken van alle
knoppen op de werkbalk. Het scherm dat verschijnt na klikken op het Tools / Time Curves /
Options tabje (Figuur 59, zie pagina 66) heeft voor volledige weergave ook ongeveer 720
pixels nodig, maar anders dan MicroFEM'’s hoofdvenster verschijnen hier schuifbalken indien
dit venster te klein is. Al met al wordt voor handig werken een minimale schermgrootte
geadviseerd van 800 (horizontaal) bij 600 (verticaal) pixels. MicroFEM werkt echter ook goed
in de ouderwetse VGA resolutie (640x480 pixels).

Instellen van een andere kaart-achtergrondkleur

Het is eenvoudig om een andere kleur dan zwart in te stellen voor de achtergrond van het

grafische deel van het scherm. Om inkt te besparen is voor deze tutorial gebruik gemaakt

van wit. Het instellen van de kleuren kan met de volgende procedure:

1. In het hoofdmenu, klik op Options > Map... Er verschijnt een dialoogvenster

2. KiIik op het Colors tabje in dit dialoogvenster

3. Er wordt een scherm getoond waar allerlei kleuren kunnen worden ingesteld (Figuur 4).
Klik op de achtergrondkleur (“Background color”) en kies uit de drop-down lijst de
gewenste kleur.

4. Laat de andere opties ongemoeid en klik op de OK-knop om de keuze te effectueren en
het scherm te sluiten.

& Map options
Crrawing mu:udel Alter-grid mode Colars I

~Background calar Colar of fowline per laver:
[ C—1 ~]

~Dirawing color
[ — - |

—Marking caolo
[ =]

—Colar of circles [- valuest——

Figuur 4: Dialoogvenster voor kleurinstellingen
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Zodra in MicroFEM met een model gewerkt wordt kan, in plaats van bovenstaande stappen 1
tot en met 4, de achtergrondkleur gemakkelijker als volgt worden ingesteld:

1. Klik op de ﬁl—knop (Tekenmodus), rechts-onder op het scherm. Indien deze knop nog
grijs is, moet de procedure nog even worden uitgesteld totdat een netwerk of model is
geladen.

2. Klik met de rechtermuisknop op de gewenste kleur in het palet op de werkbalk

I .
EFrrEmsE—. De achtergrond krijgt dan de gewenste kleur. Getekende punten en

ljnen kunnen hierdoor (lijken te) verdwijnen als de voor- en achtergrondkleur gelijk
worden. Om ze weer zichtbaar te maken kan een andere voorgrondkleur worden
gekozen door met de linker muisknop in het palet te klikken (bijvoorbeeld op het zwarte
hokje) en dan opnieuw te tekenen (bijvoorbeeld knooppunten met de F2-toets).

Om de achtergrondkleur te bewaren voor volgende runs moet de gekozen instelling worden
bewaard: Klik in het hoofdmenu op Options > Save settings.
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STAP1: EINDIGE-ELEMENTEN NETWERK MAKEN

lets over verschillende typen netwerken

MicroFEM biedt twee methoden (“netwerk generators”) aan voor het maken van een uit

driehoekige elementen opgebouwd netwerk:

1. Onregelmatige grenzen. Deze generator is handig wanneer zeer onregelmatige (vaak
geologische of geografische) grenzen zoals rivieren, meren of begraven ondoorlatende
formaties in het netwerk moeten worden opgenomen. Aan de andere kant kan het lastig
zijn om met deze netwerkgenerator een netwerk te maken wanneer het gewenst is dat
grote verschillen in elementgrootte in naastgelegen gebieden voorkomen.

2. Sterk contrast. De andere netwerkgenerator wordt aangeraden wanneer het belangrijk is
dat naastgelegen gebieden met sterk verschillende elementgrootte (en dus ook sterk
verschillende knooppuntafstanden) kunnen worden gemodelleerd. Als voorbeeld kan
worden gedacht aan een zeer kleine knooppuntafstand in en rond een bouwput, terwijl de
knooppuntafstand bij de modelrand veel groter mag zijn. Onregelmatige grenzen kunnen
met dit type generator echter minder gemakkelijk worden gemodelleerd.

Deze twee netwerkgenerators worden binnen MicroFEM nog steeds aangeduid met de
namen van de DOS-programma’s die voorheen voor het maken van genoemde
netwerktypen werden gebruikt: FemGrid voor onregelmatige-grenzen netwerken, FemMesh
voor de netwerken met sterke contrasten in elementgrootte.

Welk type netwerkgenerator het beste gebruikt kan worden in een bepaald geval ligt
grotendeels aan uw eigen oordeel en ervaring. Hierbij is het handig om het volgende te
weten:

» Als de netwerkgenerator “klaar” is kan in een later stadium het netwerk altijd weer
worden aangepast of verder verfijnd, zelfs als het model al is doorgerekend. De
netwerkgenerator kan gezien worden als een hulpmiddel om een eerste bruikbare
netwerkvariant voor het onderhanden probleem te maken;

» Zodra de netwerkgenerator “klaar” is, vervalt verder de betekenis van de gebruikte

“deelgebieden”, “segmenten”, “drichoeken” etc., begrippen die alleen nodig waren voor

het maken van het netwerk. De enige informatie die naar het model wordt meegenomen

is dat de gebruikte vaste knooppunten (“fixed nodes”) een naam (“label”) krijgen.

Selecteren van het type netwerk

Klik in de hoofdmenubalk op File; dan op New Grid. Zoals gebruikelijk in veel
Windowsprogramma’s is er ook een toetsenbord-equivalent: Alt-F, selecteer New Grid met
de pijltjestoetsen en druk op de Enter-toets.

A MicroFEM: 350
Filez Project  Miew

HEW grllj

Open...
Save all
Save as...
[Elear

Exit

Figuur 5: File > New grid dialoogvenster
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Het volgende dialoogvenster verschijnt (Figuur 6):

" Open existing Metwark file with

% Appropriate generatar
= FemfGrid
= Femhiesh

{+ Create Mew grid

" lrregular boundary grid [FermGrid)

% | arge contrast and [FemnbdeshE

k., Cancel | Help |

Figuur 6: New grid dialoogvenster

Zorg dat de keuzeknoppen "Create new grid" (Maak nieuw grid) en "Large contrast grid
(FemMesh)" (Sterk-contrast netwerk) zijn geselecteerd door klikken met de muis, klik dan op
de OK-knop. Net als in de meeste andere Windows-programma’s kunt u ook de {-toets, Tab-
toets and Enter-toets gebruiken om deze keuzes in te stellen.

Een volgend venster verschijnt, zoals in Figuur 7. Er knippert een cursor naast het eerste
kopje "Model name" (Modelnaam). Voer hier de modelnaam en andere projectinformatie in.
Met de I-toets of door klikken in opeenvolgende regels worden deze regels wit en kunnen ze
worden bewerkt. Bestaande tekst kan worden bewerkt na drukken op de F2-toets.
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Project information

Model name butariall

Project tdicraFE b tutarnial

Location zomewhers

D ate some ke

Remarksz Date / time af last change of this model

Fut all remark.s concerning ta the specific modeling steps here;

- current model zcenario

- reminders, about special izzues in thiz model and wiy they were

incorparated in this model

- Bl
| vestigatar Put yaur name here
[rate Some other date, perhaps of start of modeling project
Remarksz Put relevant project info here, ..

Project D, project phase, ...

] 8 Cancel Help

Figuur 7: Venster met ingevoerde modelnaam en projectgegevens

Het wordt sterk aangeraden om goed gebruik te maken van dit info-scherm. Ofschoon een
enkele letter in de bovenste regel genoeg is om verder te kunnen gaan, is het vrijwel zeker
dat u al snel het overzicht kwijt bent van welke modelversie en welk modelbestand voor
precies welk scenario is gebruikt, zodra de modellering maar een beetje ingewikkelder wordt.
De projectgegevens kunnen te allen tijde worden aangepast (via Project in het hoofdmenu).
Als voorbeeld kan informatie vergelijkbaar met die in Figuur 7 worden ingevoerd.

Zodra alle gegevens zijn ingevoerd en op OK is geklikt ziet het MicroFEM-venster er uit zoals
Figuur 8:

Eiles Project Yiew Commands Calculate Options Tools Import Export Help

Fiwed nodes I Trianglesl Quadranglesl

Change number to | |3 vI

Mo s-coordingte  |y-coordinate | spacing
7
2
3

| | I
Xl Dl | @l El Fived nodes | El £ > | @{l{il i

Figuur 8: Leeg netwerkgenerator-venster

3] [ N e
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Rechts ziet u een aantal kolommen met tabjes erboven (late we dit het “gegevens-venster” of
“datavenster” noemen), links een leeg wit (of zwart, als de kleur nog niet was aangepast)
gebied waar later de kaarten zullen worden getekend (“kaartvenster”). De scheidslijn tussen
het datavenster en het kaartvenster kan heen en weer gesleept worden met de muis.

Merk voorlopig op dat onderaan het MicroFEM-venster een werkbalk met knoppen prijkt,
waarvan één met de grijze tekst "Fixed nodes" (vaste knooppunten).

Vaste knooppunten invoeren

“Fixed nodes” (Vaste knooppunten) zijn de knooppunten waarvan de gebruiker de positie

opgeeft. Tijldens de opbouw van het eindige-elementen netwerk blijven deze knooppunten

altijd op hun plaats. Dit in tegenstelling tot de knooppunten die door MicroFEM zelf worden

gegenereerd en die bij de opbouw van het netwerk enigszins kunnen verschuiven. Alle

knooppunten waarvan de positie door de gebruiker wordt ingevoerd zijn per definitie vaste

knooppunten. (Na het genereren van het netwerk worden deze knooppunten automatisch voorzien

van een label “fixed node <nr>" om ze gemakkelijk terug te kunnen vinden). Vaste knooppunten

worden gebruikt voor:

o Definiéren van lijnsegmenten (bij onregelmatige-grenzen netwerken; dit wordt in deze
handleiding niet behandeld);

o Definiéren van de hoekpunten van drie- en vierhoeken (bij sterk-contrast netwerken);

o Definiéren van de exacte locaties van bijvoorbeeld putten of peilbuizen.

In ons modelnetwerk willen we de volgende zaken opnemen:

e De rivieren langs de noord- en zuidgrens van het modelgebied;

o De onttrekkingsput;

¢ De locatie van de stortplaats, voorlopig met één knooppunt;

¢ Bovendien wensen we een kleine knooppuntafstand bij de onttrekkingsput en (een wat
minder kleine) bij de stortplaats dan bij de modelgrenzen.

De vorm van het modelgebied is een eenvoudige rechthoek. Om in MicroFEM een netwerk
met een variabele knooppuntafstand te genereren dienen de stortplaats en de put expliciet
bij het opzetten van het netwerk te worden meegenomen.

Het netwerk wordt opgezet door de put en de stortplaats met een lijn te verbinden en vanaf
de stortplaats en de put lijnen te trekken naar de dichtstbijzijnde modelrand (Figuur 9). Op
deze manier verkrijgen we 6 vierhoeken en 12 vaste punten waar twee of meer lijnen met
elkaar zijn verbonden — dat soort punten moeten altijd vaste knooppunten zijn. (Het netwerk
zou ook met zes driehoeken kunnen worden gemaakt, maar dit probleem is nu eenmaal uitgewerkt op
de beschreven manier).

Vervolgens dienen de vaste knooppunten de driechoeken en de vierhoeken genummerd te
worden (Figuur 9).
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1 2 3 4
A B
11 c
10
F 12 5
E D
9 8 7 6

Figuur 9: Overzicht van de opzet van het modelnetwerk

We starten met het opgeven van het aantal knooppunten in het datavenster van MicroFEM.
We moeten ons er eerst van verzekeren dat het tabje “Fixed nodes” geselecteerd is (is dat
niet het geval, klik er dan op of druk telkens op de Tab-toets tot het huidige tabje
geselecteerd is en gebruik dan de pijltjestoetsen om het tabje “Fixed nodes” te selecteren en
druk dan op de Enter-toets).

Klik op de pijltiesknoppen totdat een aantal van 12 knooppunten wordt aangegeven, of
gebruik de Tab-toets tot het vakje met het aantal knooppunten geselecteerd is en gebruik
dan de pijltjestoetsen om het aantal knooppunten te vergroten tot 12, of voer direct “12” in
vanaf het toetsenbord.

Om dit aantal knooppunten vast te leggen en de bijbehorende tabel aan te passen, moet op
de “Change number’-knop worden geklikt.

Nu moeten de locaties van de vaste knooppunten worden opgegeven. Dit kan simpelweg
door dubbelklikken op de linkse kolom en dan de x-codrdinaat op te geven (in dit geval in m).
Door drukken op de Enter-toets wordt de ingevoerde waarde bewaard en verschuift de focus
automatisch naar de volgende cel. Als u een fout heeft gemaakt kunt u eenvoudig met de
pijltjestoetsen naar de betreffende cel “lopen” en de Enter-toets indrukken om de ingevoerde
waarde te bewerken.

In dit voorbeeldprobleem zijn alle coérdinaten opgegeven in meters. De oorsprong van het
codrdinatenstelsel kan vrij worden gekozen. Indien een lokaal codrdinatensysteem wordt
gebruikt, zoals in ons voorbeeld, ligt de oorsprong vaak in de linkeronderhoek
(zuidwesthoek) van het model.

Behalve codrdinaten dienen we voor alle vaste punten ook een knooppuntafstand op te
geven. Dat is de onderlinge knooppuntafstand die MicroFEM in het betreffende deel van het
netwerk zal toepassen. Rondom de put geven we voor dit probleem een knooppuntafstand
op van 50 m. Nabij de stortplaats, waar de stijghoogtegradiént naar verwachting veel minder
zal variéren dan dichtbij de put volstaat een grotere knooppuntafstand van 100 a 150 m. Om
binnen de capaciteitsbeperkingen van de demo-versie van MicroFEM te blijven (maximaal
2500 knooppunten) moeten we wat experimenteren; uiteindelijk zal blijken dat een
knooppuntafstand van 140 m rondom de stortplaats en een van 225 m op de modelranden
volstaat. In de volgende stappen laten we zien hoe dit experimenteren in zijn werk gaat. U
kunt zelf verder optimaliseren (en u wordt van harte aangeraden om dat dan ook te doen) totdat
het maximum aantal punten van 2500 vrijwel geheel wordt gebruikt.

Uiteindelijk, wanneer alle codrdinaten en knooppuntafstanden ingevoerd zijn, zal de knop
“Fixed nodes” op de werkbalk onderaan het MicroFEM-venster aanklikbaar worden. Klik er
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op, en u zult zien dat de ligging van de vaste knooppunten wordt weergegeven in het
kaartvenster (Figuur 10).

Filez  Project Miew Commands  Calculate  Options Tools  Import Export Help
Fixed nodes | Triangles | Quadrangles |
[ Chergeminkeris [[12 2
Mo w-coordinate |_I,J-coordinate |spacing |
1 u} EO00 225
2 3000 EO00 225
* 3 5000 5000 225
4 10000 EO00 225
[} 10000 2000 225
E 10000 I} 225
7 G000 0 225
8 3000 I} 225
9 i] 1] 225
10 u} 4000 225
11 3000 4000
1 | 12rodes | 5 | % =10000.00 y = 2000.00 L 2000 20
Xl Dll@l EI Nodesonsegmentsl El ;&,>>| il

Figuur 10: Alle vaste knooppunten ingevoerd

Ook de tekst op de “Fixed nodes”-knop verandert zodra erop is geklikt. Indien de onderlinge
ligging van de punten niet klopt of indien u anderszins niet tevreden bent met het resultaat,
kunt u simpelweg de waarden in de lijst met vaste knooppunten aanpassen, of misschien
zelfs het aantal vaste knooppunten aanpassen. De tekst “Fixed nodes” verschijnt weer (en
de knop wordt weer aanklikbaar) zodra alle benodigde informatie is ingevoerd.

Merk op dat aanvankelijk het knooppunt linksonder knippert. Maar zodra u klikt op een ander
knooppunt in het kaartvenster, dan zal in de tabel de regel met het corresponderende
knooppunt de focus krijgen. Omgekeerd, klikken op een van de regels in de tabel met vaste
knooppunten doet het corresponderende knooppunt in het kaartvenster knipperen. In Figuur
10 bijvoorbeeld is vast knooppunt nr. 11 geselecteerd in de tabel en knippert het in het
kaartvenster. Afgezien van dit handigheidje zijn, zodra alle vaste knooppunten eenmaal zijn
ingevoerd, de volgende knoppen rechtsonder op de knoppenbalk aanklikbaar:

.G_}\} Inzoomen op de plek rond het knipperende knooppunt (“huidige knooppunt”)

E‘! Uitzoomen

=8 Inzoomen op een nader aan te geven rechthoek. Na eenmaal klikken op deze
“zoomknop” kan door slepen met de muis een gebied worden aangegeven, na
loslaten van de muisknop zoomt MicroFEM in op dat gebied, zodanig dat in ieder
geval het gehele aangegeven gebied wordt getoond

Il' Bedenk dat deze knop actief blijft tot nogmaals op deze knop, of op een andere

zoomknop wordt geklikt! Als deze knop nog wel actief is en u per ongeluk ergens in
het kaartvenster klikt zal MicroFEM aannemen dat u op een heel klein gebiedje wilt
inzoomen, desnoods zover dat er nog hooguit één knooppunt zichtbaar is! (Zo'n
onbedoelde zoom-actie kunt u ongedaan maken door met de rechtermuisknop ergens in het
kaartvenster te klikken en in het dan verschijnende dialoogvenster de opdracht “Previous
view” (vorige beeld) aan te klikken. Dit werkt overigens maar één keer, dus alleen voor de
laatste zoom-actie. U kunt ook uitzoomen tot het gehele modelgebied zichtbaar wordt door in
het genoemde dialoogvenster te klikken op "Fit to scale".

I_'il Het kaartbeeld verschuiven.
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Met deze knoppen beschikt u over een effectieve en gemakkelijke manier om de ligging van
de vaste knooppunten (de hoekpunten van de drie- en vierhoeken) te controleren.

Resterende netwerkgegevens invoeren

De volgende stap is om het aantal driehoeken (= 0) en vierhoeken (= 6) in te voeren. Dit
werkt net zo als het opgeven van het aantal vaste knooppunten, alleen het tabje verschilt.

Zodra het aantal vierhoeken is ingevoerd moeten we opgeven hoe deze vierhoeken worden
gedefinieerd door hun opeenvolgende knooppunten. In Figuur 11 is deze informatie
ingevoerd voor de vierhoeken 1 tot en met 6, die corresponderen met vierhoeken A tot en
met F in Figuur 9. Zodra u deze informatie heeft ingevoerd in de computer, is alle benodigde
informatie voor het maken van het netwerk compleet. U hoeft alleen nog maar een aantal
keren op een knop te klikken en de resultaten visueel te controleren, MicroFEM doet de rest!

Filez  Project “iew Commands Calculate Ophion:  Tools  Import Export Help

Fined nodesl Triangles Huadrangles |
Change number to ||B vI
No  [Nods1 [Mode2 [Moded [Mods4 |
1 1 2 11 10
2 2 3 12 11
3 3 4 5 12
4 5 B 7 12
5 7 8 11 12
[ g g 10 11]
1 | 2415nodes | 7 | % = 5000.00 y = 0.00
x| DEe H Eements | || £ 0| 2] aje il ¢l ElEls S

Figuur 11: Alle netwerkgegevens ingevoerd

Zodra alle informatie over de driehoeken (aantal = 0 in dit geval) en vierhoeken is ingevoerd
(aantal en knooppuntnummers), wordt de knop "Nodes on segments" aanklikbaar. Nadat u
er op heeft geklikt zal MicroFEM knooppunten genereren op de verbindingslijnen
(“segmenten”) tussen de ingevoerde vaste knooppunten; wanneer MicroFEM hiermee klaar
is (meestal in een oogwenk) verandert de tekst op de knop in "Nodes in regions". Zodra alle
knooppunten op de verbindingslijnen zijn getekend kunt u klikken op het rijtjie knooppunten
rechts in het datavenster, MicroFEM zal dan de corresponderende vierhoek in geel
weergeven in het kaartvenster links (andersom, in een vierhoek klikken, selecteert niet de

corresponderende rij knooppuntnummers rechts in het datavenster. Hier is overigens een goede
reden voor).

Klik weer op de knop (nu met tekst "Nodes in regions"), en geleidelijk zal een beeld
overeenkomend met Figuur 11 (hierboven) verschijnen. Het gestaag toenemend aantal
gegenereerde knooppunten wordt continu weergegeven op de statusbalk, tezamen met het
nummer en de codrdinaten van het knooppunt dat het dichtst bij de cursor ligt.

Nadat MicroFEM hiermee klaar is, verandert de tekst op de knop in "Elements". Klik hierop
om MicroFEM te laten beginnen met het genereren van de elementen. Dit proces start aan
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de modelrand en schrijdt tegen de klok in voort totdat het gehele model met elementen is
gevuld.

Zodra de elementen zijn gegenereerd kunnen individuele drie- en vierhoeken worden
aangegeven door rechts in het datavenster te klikken op de rijties knooppunten die de drie-
en vierhoeken definiéren.

In vervolgstappen verandert de tekst op de knop in "Relax grid" en "Renumber nodes". Relax
grid houdt in dat alle door MicroFEM gegenereerde knooppunten binnen de drie- en
vierhoeken (d.w.z., niet de vaste knooppunten waarvan de locatie is opgegeven, en ook niet de
knooppunten die MicroFEM op segmenten tussen vaste knooppunten heeft gegenereerd) worden
verschoven naar een nieuwe locatie precies in het midden van alle aangrenzende
buurknooppunten. Omdat die buurknooppunten op hun beurt natuurlijk ook worden
verschoven verloopt dit proces iteratief (d.w.z. de aanpassing wordt een aantal malen herhaald);
MicroFEM doet drie “rondjes” door het gehele netwerk. Uiteindelijk resulteert dit in een
netwerk waarin “scherpe” en “stompe” hoeken van de elementen zoveel mogelijk worden
vermeden, wat helpt bij het terugdringen van numerieke fouten bij latere berekeningen.

“Renumbering nodes” (knooppunten hernummeren) wordt ook aangeraden, maar is meer
van belang voor een overzichtelijker boekhouding. De oorspronkelijke knooppunthummers
(beginnend met vaste knooppunten, dan knooppunten op segmenten en dan in drie- en vierhoeken)
wordt vervangen door een nummering die min of meer regelmatig van één kant van het
model naar de andere loopt; aan elkaar grenzende knooppunten hebben daarna een
eveneens min of meer overeenkomend knooppuntnummer. Deze hernummering heeft geen
invloed op de rekennauwkeurigheid, maar wel op de volgorde waarin delen van kaarten
worden getekend.

De oorspronkelijke knooppuntnummers van de opgegeven vaste knooppunten worden door
MicroFEM overigens bewaard en kunt u gemakkelijk terugvinden (zie p. 21).

Het resultaat van alle voorgaande stappen is het netwerk van Figuur 12.

Eiles Project “iew Commands Calculate Opfions Tools Import Export Help

Fixed nodes | Triangles Quadiangles |

Change number to | IE vl

No  [Modet |Nnde2 |Node3 Mode 4
2 10

12 1
5 12
7 12
1 12
10 1

M| m| | | P =
L I B
w00 I e )

Decer | zs | 2#15nodes | |

Xl Dl | @'l EI Fixed nodes | El & >> |
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Figuur 12: Het complete eindige-elementen netwerk

Voor de volledigheid kijken we nog even naar de knoppen op de werkbalk onderaan het
MicroFEM-venster. Van links naar rechts ziet u (Figuur 12):

ﬁi Dient om alle ingevoerde netwerkgegevens te wissen en dan naar het lege
MicroFEM-venster van Figuur 3 terug te keren.

=]

Wist alle ingevoerde netwerkgegevens.

7]

Voert alle gegevens in voor een simpel voorbeeld van een sterk-contrast netwerk.

&

Voert alle gegevens in voor een zeskantig netwerk. MicroFEM vraagt alleen naar de
coordinaten van het middelpunt en de afstand tot de rand. Dit netwerk is bedoeld als
startpunt voor bepaalde civieltechnische toepassingen.

&

Deze knop is niet aanwezig in de sterk-contrast netwerkgenerator, alleen in de
onregelmatige-grenzen netwerkgenerator. Leest de x- en y-codrdinaten van vaste
knooppunten uit een ASCII tekstbestand.

it

Voegt een knooppunt, drie- of vierhoek, segment of deelgebied in, afhankelijk van de
actieve tab in het datavenster.

]

Bewaart de ingevoerde netwerkgegevens. Alleen wanneer er een compleet netwerk
gegenereerd is bewaart MicroFEM ook alle informatie over de gegenereerde
knooppunten en elementen.

&> Schakelt over van netwerk- naar modelmodus.

Het wordt ten sterkste aangeraden om voor we verdergaan naar de modelmodus (waarin we
de modelgegevens invoeren) alle gegevens op te slaan of schijf:

Klik op de El-knop en bewaar in het daarop volgende dialoogvenster de netwerkgegevens
als een "Network” (.fen) bestand in een map naar keuze. Merk op dat de suggestie die
MicroFEM doet voor de bestandsnaam afkomstig is van de tekst op de eerste regel ("Model
name") van het Project-information venster (Figuur 7).

N.B. Als u niet zelf de netwerkgegevens opslaat als een fen-bestand zal MicroFEM u er aan
herinneren om dat te doen.
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STAP 2: HET MAKEN VAN EEN MODEL UIT HET NETWERK

Alles is nu gereed om van het 2D-netwerk een 3D-model te maken door het toevoegen van
de verticale dimensie (aantal lagen) en het invoeren van de bijbehorende hydraulische

eigenschappen. Klik op de f‘_>>!—knop en het volgende dialoogvenster verschijnt (Figuur 13):

M Aquiters -0 x|

Murnber of aquifers -

Q. Cancel |

Figuur 13: Aantal watervoerende pakketten

De standaardwaarde (één) voor het te modelleren aantal “aquifers” (watervoerende
pakketten) voldoet voor ons voorbeeldprobleem. Klik op de OK-knop of druk op de Enter-
toets, MicroFEM schakelt dan door naar de "model-modus” (Figuur 14):

Filez  Project “iew Command: Calculate Option: Tool:  Import Export Help
F'araml
0 |head [m] fO.000
1 |wert. res. [d] |0
g ]
§ - hfead [m] | 0.000
W dizcharge [re/d] |0
1404 | 1:1E5 | 2335 || w=811409 p=1429.44 label 1 |
| | el ededed o] el 24 |- %

Figuur 14: MicroFEM modelvenster, Loopmodus

Binnen het nu getoonde scherm vallen diverse delen te onderscheiden:

o Een kaartvenster aan de linkerkant, waar het eindige-elementen netwerk is weergegeven

e Het datavenster rechts, met een lijst van hydraulische eigenschappen (parameters) en
randvoorwaarden (zie verderop). Merk op dat onderaan dit venster een regel is
verschenen met de tekst "label 1"; strikt genomen hoort dit ook bij het datavenster

¢ De knoppenbalk onderaan, met de zoom/pan-knoppen en een aantal nieuwe knoppen
aan de linkerkant en uiterst rechts

o De statusbalk juist boven de knoppenbalk
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Intermezzo: Overzicht van MicroFEM “modi”

Rechts onderaan het MicroFEM-venster zijn vier nieuwe knoppen verschenen; elk daarvan
dient om over te schakelen naar een bepaalde modus (werkstand):

il (modus 1) Loopmode. Hierin kan door het netwerk worden “gelopen” (vandaar de
naam), knooppunten kunnen worden gemarkeerd (zie verder) en waterbalansen
kunnen worden berekend.

("]

(modus 2) Invoermodus. Voor het invoeren van hydraulische parameterwaarden,
randvoorwaarden, stijghoogtes en het opslaan en inlezen van “parameter’-bestanden
(zie eveneens verderop).

2

(modus 3) Tekenmodus. Voor het weergeven van isolijnenkaarten, geselecteerde
delen van het netwerk, stroomlijnen, dwarsdoorsneden, stijghoogteprofielen, etc, alles
in door de gebruiker op te geven kleuren.

ﬁl (modus 4) Netwerkmode. Hierin kan het netwerk en het aantal lagen worden
aangepast: o.a. knooppunten toevoegen en/of verwijderen, omklappen van koordes
(zie verder), optimaliseren van het netwerk, toevoegen en/of verwijderen van
watervoerende en slechtdoorlatende lagen.

MicroFEM begint standaard in Loopmode wanneer het is opgestart of wanneer een model of
netwerk is ingelezen.

Het MicroFEM venster in Loopmodus

Het kaartvenster
Zorg dat MicroFEM in Loopmodus staat; klik hiertoe eventueel op de ﬂ-knop.

In het midden van het modelgebied in Figuur 14 is een klein wit “gat” zichtbaar. In het
MicroFEM-venster op de computer knippert hier een dikke stip. Na inzoomen op dit gat (de
zoomknoppen zijn dezelfde als die bij het maken van het netwerk, zie p. 15) zal blijken dat deze
knipperende stip in werkelijkheid een knipperend knooppunt van het eindige-elementen
netwerk is. Dit knipperende knooppunt is het “huidige knooppunt” (current node). Rechts in
het datavenster staan de waarden van de hydraulische eigenschappen en de
randvoorwaarden die horen bij dit knooppunt.
Op de stutusbalk onder het kaartvenster is (van links naar rechts) de volgende informatie
weergegeven (in het voorbeeld van Figuur 14):
1404 Het knooppuntnummer (van het huidige knooppunt)
1:1E5 De schaal van de kaart (in dit geval 1:100.000). Uiteraard hangt deze schaal sterk af
van de grootte en resolutie van de gebruikte monitor, maar het is wel een goede
benadering van de schaal van plaatjes (“bitmaps”) die naar het klembord en een
printer kunnen worden gestuurd
2335 Het knooppuntnummer van het knooppunt dat het dichtst bij de muiscursor staat
x=8104.09, y=1429.44
Dit zijn de x- en y-cooérdinaten van het knooppunt dat het dichtst bij de muiscursor

staat. Alleen wanneer de “zoom area” knop (:&)) is ingedrukt worden de x- and y-
codrdinaten van de muiscursor zelf weergegeven.

Bij bewegen van de muiscursor over het scherm zult u zien dat de informatie over de twee
laatstgenoemde velden continu wordt geactualiseerd. Indien de muiscursor het modelgebied
verlaat maar nog wel binnen het kaartvenster blijft, zal nog steeds de informatie van het
dichtstbijzijnde knooppunt worden weergegeven. Wanneer de muiscursor buiten het
kaartvenster komt, worden geen waarden weergegeven.
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De parameterlijst
In het datavenster rechts ziet u de tekst “Param” bovenaan. Merk op dat dit eigenlijk op een
tabje staat. In de volgende paragrafen zult u zien dat er tabjes kunnen worden toegevoegd
met teksten als “Top”, “Thick”, enz.
Onder het tabje “Param” staat de volgende lijst:

0 head [m] 0.000

1 vert.res. [d O
trans. [m2/d] O
head [m] O

discharge [m3/d] 0.000

In de eerste kolom staat een laagnummer. Op elke regel staat een “parameter”. Elke
parameter heeft ook een code die niet is weergegeven; van boven naar onder is dit:
h0 (“0 head”) vaste stijghoogte aan de bovenkant van het model
c1 (“1 vertres.”) verticale weerstand van een (slechtdoorlatende) laag boven het

1° (bovenste) watervoerende pakket
t1 (“ trans.”) doorlaatvermogen (KD-waarde) van het 1° watervoerende pakket
h1 (“ head.”) stijghoogte in het 1° watervoerende pakket
g1 (“ discharge”) (eventuele) onttrekking aan het 1° watervoerende pakket
Indien er meer dan één watervoerend pakket is, volgen daaronder voor elk pakket steeds
vier regels. De bijbehorende codes worden doorgenummerd: ¢2, t2, h2, q2, c3, ... etc.
Watervoerende lagen worden dus geteld van boven naar beneden, met laag 1 als bovenste
watervoerend pakket.

In MicroFEM is de bovenrandvoorwaarde standaard een “potentiaal-afhankelijke flux”, wat
wil zeggen dat de kwel of infiltratie afhankelijk is van de stijghoogte in het bovenste pakket
en van twee parameters die door de gebruiker moeten worden opgegeven. Deze parameters
Zijn de vaste potentiaal h0 en de verticale weerstand c1:

o hO0is een vaste potentiaal (grondwaterstand, waterpeil) aan de bovenzijde van het model,
bijvoorbeeld een polderpeil in een slechtdoorlatende deklaag of het waterpeil van
oppervlaktewater. De waarde wordt uitgedrukt als hoogte boven een bepaald
referentieniveau; voor dat referentieniveau wordt vaak impliciet een nationale standaard-
referentiehoogte aangenomen (bijv. NAP in Nederland of TAW in Belgié) maar het kan
eigenlijk elk gewenst niveau zijn. Uiteraard dient voor alle (stijg)hoogtes en
(grond)waterstanden in een model hetzelfde referentieniveau te worden aangehouden

o c1is de (verticale) hydraulische weerstand aan de bovenzijde van het model,
bijvoorbeeld de weerstand van een deklaag of rivierbodem. De infiltratie aan de
bovenzijde van het model is evenredig met het potentiaalverschil (h0-h1) en omgekeerd
evenredig met de weerstand ¢1. Als (h0-h1) negatief is, is de stroming omhoog (kwel).
Wanneer de weerstand oneindig groot is (volledig ondoorlatende laag), moet in
MicroFEM de waarde 0 (nul) worden ingevoerd. MicroFEM zet aan het begin alle
waarden en dus ook alle weerstanden op 0 (nul). Aan de bovenzijde van freatische en
van afgesloten watervoerende pakketten (volkomen spanningswater) treedt geen
potentiaal-afhankelijke voeding op. In die gebieden wordt de lekke bovenrandvoorwaarde
“uitgezet” door een waarde van 0 (nul) toe te kennen aan de verticale weerstand ¢1 aan
de betreffende knooppunten. In die gevallen doet de waarde van hO er niet toe. Zodra er
wel een waarde groter dan nul wordt ingevoerd voor ¢1 is in het betreffende gebied het
watervoerend pakket “lek” en wordt de verticale voeding berekend als (h0-h1)/c1.

Klik nu op de zuidwestpunt van het modelnetwerk, op het knooppunt dat tijdens het maken
van het netwerk nummer 6 was. Aan de linkerkant van de statusbalk wort het actieve
knooppuntnummer aangegeven, en dit is waarschijnlijk niet nummer 6. Maar onderaan het
datavenster staat in de grijze cel naast de aanduiding “label 1” de tekst "fixed node 6". Deze
tekst "fixed node 6" is simpelweg een naam die is toegekend aan dit knooppunt (en heeft niets
te maken met de “fixed heads” (vaste stijghoogten) die worden behandeld op bladzijde 32). Aan elk
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knooppunt of groep van knooppunten kunnen maximaal vijf verschillende namen worden
toegekend. Die namen (“labels”) kunnen op veel manieren handig worden gebruikt,
bijvoorbeeld bij het “markeren” van groepen knooppunten. In MicroFEM betekent "markeren”
hetzelfde als “selecteren”, namelijk het tijdelijk kiezen een willekeurige groep knooppunten,
om daar vervolgens eenzelfde bewerking op uit te voeren.

Tijdens het genereren van het netwerk (of preciezer: tijdens de “Renumber nodes”-stap) kent
MicroFEM soortgelijke namen als “fixed node 6” toe aan alle opgegeven vaste knooppunten,
met als doel om deze knooppunten later bij het invoeren van de modelgegevens gemakkelijk
terug te kunnen vinden.

Efficient invoeren van waarden en randvoorwaarden

Om te voorkomen dat de gebruiker moeizaam knooppunt voor knooppunt, laag voor laag en
parametertype voor parametertype, duizenden of meer individuele waarden moet invoeren
kent vrijwel alle grondwatermodelprogrammatuur een of ander mechanisme om snel en
efficiént waarden in te voeren voor groepen knooppunten. MicroFEM heeft hiervoor een
tweetraps-procedure:

1. Een aantal knooppunten (op een lijn, in een gebied maar zonodig ook ruimtelijk niet
gerelateerd) wordt “gemarkeerd”. Dit markeren is alleen maar noodzakelijk om de
knooppunten te selecteren waaraan waarden gaan worden toegekend.

Knooppunten kunnen interactief zowel één voor één, langs een lijn of binnen een bepaald
gebied worden gemarkeerd. Voor het handig markeren van bepaalde groepen
knooppunten zijn er handigheidjes in MicroFEM ingebouwd.

Een zeer krachtige methode is om gebruik te maken van “labels”. Zoals boven
aangegeven kan elk knooppunt verschillende labels hebben. MicroFEM heeft een aantal
gereedschappen om knooppunten te selecteren waarvan de label voldoet aan bepaalde
door de gebruiker te stellen voorwaarden.

2. Waarden kunnen in één keer worden toegekend aan alle gemarkeerde (of juist niet-
gemarkeerde) knooppunten.

Het in één keer toekennen van waarden aan een aantal gemarkeerde knooppunten wil niet
zeggen dat dan al die knooppunten dezelfde waarde krijgen. Er kunnen ook formules worden
gebruikt waarin parameter codes of variabelen voorkomen die voor elk (gemarkeerd)
knooppunt een verschillende waarde hebben.

Naast het toekennen van waarden worden knooppuntmarkeringen bijvoorbeeld ook gebruikt
voor het tot bepaalde gebieden beperken van isolijnenkaarten in Tekenmodus en het
toevoegen of verwijderen van knooppunten in de Netwerkmodus.

Een groot voordeel van het gebruik van labels en markeringen is dat waarden hiermee ook

kunnen worden toegekend aan meerdere, elkaar niet rakende gebieden. Labels worden met
het model opgeslagen; markeringen zijn altijd tijdelijk en worden nooit opgeslagen.

Markeren van de rivierknooppunten

We zullen beginnen met het toekennen van namen aan de rivieren door deze te markeren en
dan een naam op te geven aan de gemarkeerde knooppunten.

1. Ga naar de Loopmodus: klik op de il—knop.
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2. Klik nu op de ﬁ-knop, of druk op de F10-toets, of selecteer Command > Automarker
uit het hoofdmenu.

3. Kilik op een van de hoekknooppunten (in dit geval zijn alle hoekknooppunten
rivierknooppunten).

Hiermee wordt het aangeklikte knooppunt gemarkeerd. Dit wordt door MicroFEM aan-
gegeven met een gele rand rondom het knooppuntnummer op de statusbalk (zie Figuur 15):

LR S e T e T e
AR T Ay

7
AR AR P oA

B9 | 115 | e; | #=0.00 y=0.00
0 R R R el 1

Figuur 15: Voorbeeld van statusbalk die een gemarkeerd knooppunt aangeeft

MicroFEM geeft op dezelfde manier aan of het knooppunt dat het dichtst bij de muiscursor
ligt, gemarkeerd is. Bij het aanklikken van een knooppunt met de muis, wordt het
aangewezen knooppunt het actieve (is knipperende) knooppunt, en zijn beide nummers op
de statusbalk dus gelijk.

Om een markering van een individueel knooppunt ongedaan te maken, klikt u met de
rechtermuisknop op het betreffende knooppunt. Op deze manier punten markeren en
markeringen verwijderen, werkt alleen wanneer de ﬁl—knop ingedrukt is.

Uiteraard kunt u nu doorgaan met het markeren van alle rivierknooppunten. Houd de
linkermuisknop ingedrukt en sleep de muiscursor secuur over alle knooppunten die u wilt

markeren. De verbindingslijnen tussen gemarkeerde punten worden geel. Wanneer een
rivier geheel gemarkeerd is, kunt u op dezelfde manier de andere rivier markeren.

Zodra beide rivieren gemarkeerd zijn, kunt u de Automarkeerknop i deactiveren door er
nogmaals op te klikken.
Als alternatief kan ook het “lijnmarkeer’-gereedschap gebruikt worden.

1. Verwijder eerst alle markeringen in het hele model: klik hiertoe simpelweg op de _|
knop (“Delete marks”) of druk op de Del-toets.

2. Klik op de _I-knop om de Lijnmarkeerder te activeren. U kunt hiertoe ook de F11-toets
indrukken of Command - Line marker uit het hoofdmenu selecteren om dit gereedschap
aan te zetten (ook dit is een aan/uitknop, een zogenaamde “toggle”).

3. Kilik op een van de hoekknooppunten.

4. KIlik daarna op het knooppunt dat aan het andere einde van de betreffende rivier ligt. U

zult zien dat alle koorden (verbindingslijnen tussen de knooppunten) van de rivier nu geel
worden. Dit betekent dat alle knooppunten op de lijn gemarkeerd zijn.

5. Klik tweemaal op de _I-knop om de Lijnmarkeerder eerst uit, en vervolgens weer aan te
zetten.

6. Klik op een hoekknooppunt van de andere rivier.
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7. Klik daarna op het knooppunt aan het andere einde van deze rivier. U zult zien dat ook
alle koorden van deze rivier nu geel (=gemarkeerd) worden.

8. Klik nog een keer op de _|-knop om hem af te zetten (niet vergeten!).

N.B. Als vergeten wordt om de Lijnmarkeerder tijdelijk uit te zetten (in stapje 5), dan zullen alle
knooppunten op een lijn tussen het einde van de eerste rivier en het eerst aangeklikte
hoekknooppunt van de tweede rivier ook gemarkeerd worden.

Er is geen hulpmiddel om zo’n ongewenste markeringsactie ongedaan te maken. De snelste
manier is in dit geval om eerst alle markeringen om te draaien (F9-toets), de per ongeluk
gemarkeerde lijn opnieuw te markeren met de Lijnmarkeerder en vervolgens alle markeringen
opnieuw om te draaien (F9-toets).

Hiermee zijn (de knooppunten van) beide rivieren gemarkeerd. Alle verbindingslijnen tussen
de rivierknooppunten zijn geel, waardoor de loop van de rivieren duidelijk wordt aangegeven.

Namen aan de rivierknooppunten toekennen

1. Klik op de gl—knop rechtsonder op de werkbalk (Invoermodus) of druk gelijktijdig op de
Alt- en de 2-toets. Nu is MicroFEM in Invoermodus.

2. Kilik op de cel rechts van "label 1" onderaan het datavenster. Deze cel is dan
geselecteerd (blauw).

3. Kilik nog een keer op deze zelfde cel om hem gereed te maken om invoer te ontvangen.
De cel wordt dan wit en de tekst die er in stond krijgt een blauwe achtergrond.
Typ het woord "rivier" in (zonder aanhalingstekens)

Klik op de M—knop (Marked nodes) of druk op de F3-toets.

Nu hebben alle gemarkeerde knooppunten (beide rivieren) de naam "rivier" in het label 1-
veld. Door gebruik te maken van de "Marked nodes"-knop wordt deze naam toegekend aan
alle gemarkeerde knooppunten.

Wellicht is het u opgevallen dat de @l—knop, die oorspronkelijk grijs was, nu een rood icoon

heeft gekregen (@). Dit is de "Undo"-knop — hiermee kunt u de laatste invoerhandeling
ongedaan maken. Na klikken op deze knop worden alle zojuist ingevoerde waarden hersteld
tot wat ze voor de laatste invoerhandeling waren, en de Undo-knop wordt weer grijs.

Zoals mag worden verwacht, zijn er ook knoppen om alleen waarden toe te kennen aan de

niet-gemarkeerde knooppunten (_Dl of F4) of aan alle knooppunten ongeacht of ze

gemarkeerd zijn of niet ( [ of F5). Daarnaast is er ook de = -knop, die bedoeld is om te
gebruiken als het actieve knooppunt in een niet gemarkeerd gebied staat wat volledig
omgeven is door gemarkeerde knooppunten; hiermee wordt de waarde toegekend (of de
formule geévalueerd) aan al de niet-gemarkeerde knooppunten in dat gebied (“tot aan” de

gemarkeerde knooppunten). De El-knop werkt analoog en kent de waarde ook toe tot en
met de wel gemarkeerde knooppunten die direct grenzen (met een koorde verbonden zijn)
aan het niet-gemarkeerde gebied.

Intermezzo: Markeringen verwijderen

Om alle markeringen te verwijderen hoeft u alleen maar op de _l-knop te klikken (“Delete
marks”) in de Loop- of in de Invoermodus.
Om alleen maar een paar specifieke markeringen weg te halen kunt u het beste de

Automarker (ﬁl) aanzetten en de betreffende markeringen weghalen door één voor één op
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alle betreffende knooppunten rechts te klikken, of de muiscursor over die knooppunten te
slepen met de rechtermuisknop ingedrukt.
Soms kan de volgende truc handig werken:

1.

Ga naar de Loopmodus en klik op de _|-knop (“Toggle all marks”). Alle gemarkeerde
knooppunten worden dan niet gemarkeerd en omgekeerd. In het kaartvenster zal
meestal het grootste gedeelte van het modelnetwerk geel worden.

s

Gebruik nu de markeringshulpjes (= of _|-knoppen) om die knooppunten te markeren
waarvan u de markeringen juist weg wilde halen (merk opdat u in een soort omgekeerde
markeringstoestand werkt).

Klik nogmaals op de ___I-knop om de juiste markeringstoestand weer terug te zetten.

Controleren of alle rivierknooppunten dezelfde naam hebben

Er is een snelle manier om te zien welke knooppunten welke naam hebben:

1.

Ga naar de Tekenmodus door op de ﬁl—knop te klikken, of Alt-3 in te toetsen, of View =
Tekenmodus uit het hoofdmenu te kiezen. Het kaartventer wordt gewist en alleen de

knooppunten worden getoond.
. . . Enllllrrr .
Kies een geschikte kleur uit het palet FETI" =W/ op de werkbalk, bijvoorbeeld

rood.
Klik op de knop (“Draw contours”) of druk op de F7-toets.

U ziet nu het volgende dialoogvenster (Figuur 16):

M iriimmwr IU ] 4
i 0

el i I Cancel

[rtemal IU. 5

[ “within specified range

Help

[~ Innon-marked area only

Figuur 16: Isolijnen dialoogvenster (1)

Klik op de OK-knop of druk op de Enter-toets.

5. Het resultaat is een kaart als in Figuur 17:

Figuur 17: Isolijnenkaart van label 1
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Omdat labels nu eenmaal geen continue numerieke parameter zijn tekent MicroFEM
scheidingslijnen tussen knooppunten die verschillende namen voor het betreffende label
hebben.

U kunt nu eenvoudig vaststellen of de rijen knooppunten langs de onderste en bovenste
modelrand dezelfde “waarde” of naam hebben. Door te klikken op een van die knooppunten
kunt u zien dat die de naam “rivier” heeft. Uit Figuur 17 volgt logischerwijs dat alle
aangesloten rivierknooppunten dezelfde naam moeten hebben.

U kunt zich nog afvragen waarom er nog enkele kleine rondjes schijnbaar toevallig in het
model zichtbaar zijn. Klikken op die knooppunten zal doen blijken dat er nog namen in staan
als "fixed node ...".

Intermezzo: wissen van isolijnenkaarten
Als u veel gebruik maakt van isolijnenkaarten om invoer te controleren zal het kaartvenster al
gauw onoverzichtelijk worden. Om isolijnenkaarten te verwijderen kunt u het volgende doen:
1. Kies “Options” > “Map ...” in het hoofdmenu.
2. In het pop-up venster dat volgt selecteert u de ongewenste “Drawing component” en
drukt u op de Delete-knop.
Op deze manier kan elk (on)gewenst onderdeel van een kaart worden verwijderd.

Namen invoeren voor de stortplaats en de put

U weet nu hoe namen moeten worden ingevoerd. Maar hoe “kun” je nu snel naar het
knooppunt toegaan waar de put of de stortplaats zijn gesitueerd?

Ook daar is een oplossing voor: weet u nog dat alle vaste knooppunten tijdens het maken
van het netwerk een naam kregen als “fixed node <nr>"? De stortplaats en de put waren
knooppunt nr. 11 en 12, dus nu hebben ze labelnamen "fixed node 12" en "fixed node 11". In
MicroFEM kunt u snel naar een knooppunt met een bepaalde naam springen.

1. Ga naar Loopmode (klik op de il—knop).
2. Klik een keer op de tekst "label 1" of op de cel ernaast, om dat label actief te maken.

3. Klik op de '_"I-knop (“Jump to node”) of druk op de F12-toets. Een dialoogvenster
verschijnt (Figuur 18):

Jump: Yo node

Jump
= Mumber
% hext label Close
= Mext wel
Mode label : Help
fixed node 12 j
e L

Figuur 18: "Jump-to" dialoogvenster

4. Vanwege stap 2 is de radioknop "Next label" automatisch geselecteerd (Had u in stap
geklikt op een cel naast “discharge”, hoger op in het datavenster, dan zou “Next well” zijn
geselecteerd. Klikken op elke andere parameter zou in het dialoogvenster van Figuur 18 de knop
“Number” actief hebben gemaakt).

5. Klik op het kleine driehoekje onder “Node label” en kies in de drop-downlijst "fixed node
12"

6. Klik op de "Jump"-knop.

7. Klik op de "Close"-knop.

December 2010 26 van 68



MicroFEM handleiding versie 4.10

Nu is het knooppunt waar de put moet komen het actieve knooppunt geworden; de tekst
"fixed node 12" staat nu in het label 1-veld. Eventueel (als u aanvankelijk zo ver had
ingezoomd dat het knooppunt buiten het kaartvenster viel) is het kaartvenster automatisch zo
verschoven dat het knooppunt midden in het kaartvenster ligt. Nu kunt u een naam invoeren
voor de put:

1. Ga naar Invoermodus (klik op de gl—knop)

2. Controleer of label 1 actief is (klik zonodig in de cel rechts van "label 1" om de parameter
te activeren)

3. Druk op de Enter-toets om de celinhoud te bewerken. De donkerblauwe achtergrond
wordt wit.

4. Toets het woord "put" in (zonder aanhalingstekens) en druk weer op de Enter-toets.

Klaar!

Het wordt aan de lezer overgelaten om het knooppunt met de stortplaats een naam te geven.

NB: MicroFEM kan niet alleen naar een knooppunt met een bepaalde naam springen, maar
ook naar een met een bepaald knooppuntnummer, of naar een put in een bepaald
watervoerend pakket. In de On-line Help worden alle mogelijkheden uitgebreid beschreven.

Formules en parameterwaarden gebruiken

In MicroFEM hoeft in numerieke invoervelden niet per se een getal te worden ingevoerd. In
bijna alle gevallen waar numerieke invoer verwacht wordt, leest MicroFEM de invoer eerst
met een formule-interpretator (die vanzelfsprekend geen enkel probleem heeft met getallen).
Hieronder wordt veelvuldig van deze mogelijkheid gebruik gemaakt.

¢ MicroFEM herkent +, -, *, / en * (macht) als operatoren. Gebruik waar nodig haakjes om
de evaluatievolgorde op te geven. Een aantal standaard wiskundige functies zoals abs(),
sin() and exp() wordt ook herkend.

¢ In de formules mogen ook “variabelen” en “parameters” worden gebruikt; dit zijn
bepaalde symbolen die voor verschillende knooppunten verschillende waarden krijgen.
Tot de ingebouwde variabelen behoort: r (afstand tot actieve knooppunt), d (afstand tot
dichtstbijzijnde gemarkeerde knooppunt), p (“present value” (huidige waarde) van de
geselecteerde parameter), a (invloedsoppervlak van een knooppunt) en nog veel meer.
Met Parameters worden de reeds eerder gedefinieerde codes bedoeld, zoals: h1 voor de
stijghoogte in het (bovenste) watervoerend pakket, t1 voor het doorlaatvermogen
(transmissiviteit) van dit pakket, en ¢5 voor de verticale weerstand van de
slechtdoorlatende laag boven watervoerend pakket 5).

¢+ MicroFEM verwacht altijd een "." (punt) als decimaalscheidingsteken, onafhankelijk van
de landinstellingen van uw computer!

De On-line HELP bevat uitgebreide informatie en een compleet overzicht van alle functies,

variabelen en parameters (zie hoofdstuk: “Input of model data”, paragraaf "Using Formulas”).
Invoeren van waarden voor hydraulische parameters

We zijn nu gereed om het model te vullen met parameterwaarden.

Klik op de E|—knop (rechtsonder op de werkbalk). MicroFEM is nu in Invoermodus, ook
herkenbaar aan de blauwe kleur van de actieve parameter cel.
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Verticale weerstand van de deklaag
Allereerst is van belang dat we een freatisch watervoerend pakket modelleren. Dit houdt in
dat er een vaste, door de gebruiker opgegeven voeding uit neerslagoverschot is, en geen
potentiaal-afhankelijke voeding. Om die potentiaalafhankelijke voeding te vermijden moet de
bovenrandvoorwaarde een ondoorlatende bovenrand zijn. Die wordt in MicroFEM
gemodelleerd door opgeven van een waarde van nul (door MicroFEM geinterpreteerd als
oneindig) voor de verticale weerstand ¢1. Hoewel nul de standaardwaarde is voor een nieuw
model zullen we dit toch invoeren voor de deklaag, al is het maar voor de zekerheid.

1. Klik op een willekeurig knooppunt in het kaartvenster.

2. klik op de cel rechts van "vert.res. [d]" in het datavenster. Klik nogmaals op dezelfde cel
om hem te openen voor invoer.
Als u nu simpelweg op de Enter-toets drukt wordt de waarde in de cel alleen maar
toegekend aan de verticale weerstand ¢1 in het huidige knooppunt. Dit is niet de
bedoeling.

3. Klik op de g—knop (links op de werkbalk), of druk op de F5-toets (“All nodes”). Als u dit
gedaan heeft hebben alle knooppunten van het model nu dezelfde waarde (in dit geval
nul) toegekend gekregen.

Misschien heeft u opgemerkt dat de g—knop, die eerst grijs was, nu rood (@) is geworden.
Dit is de "Undo"-knop, waarmee (alleen) de laatste invoer ongedaan gemaakt kan worden.
Als u op deze knop klikt worden alle waarden hersteld tot wat ze waren voor de laatste
invoeractie, en de Undo-knop wordt weer grijs.

Controle op ingevoerde waarde voor de verticale weerstand
Om er zeker van te zijn dat alle knooppunten dezelfde verticale weerstanden hebben kunt u
een isolijnenkaart tekenen. Kijk nog eens naar "Controleren of alle rivierknooppunten
dezelfde naam hebben” (pagina 25) om te zien hoe zo’n isolijnenkaart wordt getekend; let er
op dat in dit geval de verticale weerstand van c1 (vert. res.) als actieve parameter is
ingesteld. Omdat alle knooppunten dezelfde waarde voor ¢c1 hebben kan er geen
isolijnenkaart worden getekend, MicroFEM geeft een pop-up venster met de melding
“Constant value’; klik dan gewoon op de OK-knop.

(Startwaarden voor) transmissiviteit van het watervoerend pakket
MicroFEM werkt met transmissiviteiten (KD-waarden, doorlaatvermogens) in plaats van
permeabiliteiten (K-waarden, doorlatendheden). Omdat we nu werken met een freatisch
pakket met een bepaalde opbolling tussen de twee rivieren (vanwege voeding uit neerslag
en afstroming naar die rivieren), weten we het uiteindelijke doorlaatvermogen (product van
doorlatendheid en verzadigde dikte) nog niet.
Om met freatische condities te kunnen rekenen heeft MicroFEM een ingebouwde procedure.
Hiertoe wordt echter gebruik gemaakt van een “batch”-file. Omdat we het werken daarmee
nog even willen uitstellen tot een wat later stadium, zullen we de verzadigde dikte eerst
uitrekenen met een stap voor stap (iteratieve) procedure.

Om te beginnen vermenigvuldigen we simpelweg de doorlatendheid van 12 m/d met de
verzadigde dikte van het pakket ter plaatse van de rivieren. Die rivieren worden
verondersteld volledig ingesneden te zijn, dus gaan we ervan uit dat de verzadigde dikte van
het pakket gelijk is aan de diepte van de rivier (35 m van waterspiegel tot rivierbodem). Bij
een verzadigde dikte van 35 m bedraagt het doorlaatvermogen 35 m X 12 m/d = 420 m?/d ter
plaatse van de rivierknooppunten. We voeren deze waarde in als eerste schatting
(startwaarde) voor het doorlaatvermogen van ALLE knooppunten:

1. Druk op de Alt-2 toetsen om in Invoermodus te komen
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2. Klik op een willekeurig knooppunt in het kaartvenster
3. Dubbelklik op de transmissiviteitswaarde in het datavenster

4. Tikin: 12 * 35 als waarde voor het doorlaatvermogen en laat dit precies zo staan, laat
alle toetsen en knoppen verder onaangeroerd (de celachtergrond moet nog wit zijn)

5. Klik nu op de gl—knop of druk op F5. De transmissiviteitscel heeft nu een blauwe
achtergrond en bevat een getal. MicroFEM heeft simpelweg de door u ingevoerde
bovenstaande formule voor elk knooppunt uitgerekend en toegekend.

Terzijde: MicroFEM werkt voor wat betreft formules net zoals een spreadsheetprogrammma.
Eerst kopieert het de formule naar alle gewenste knooppunten en dan pas evalueert
MicroFEM de formule, in plaats van dat eerst de formule in het actieve knooppunt
geévalueerd wordt en dan pas de uitkomst daarvan naar alle gewenste knooppunten wordt
gekopieerd.

Zoals nu bekend mag worden verondersteld, kunt u de uitkomst van de invoeractie
controleren door een isolijnenkaart van de transmissiviteit te tekenen (zie pagina 25
"Controleren of alle rivierknooppunten dezelfde naam hebben").

Invoeren van randvoorwaarden

Bovenrandvoorwaarde

Een belangrijk onderdeel van de benodigde bovenrandvoorwaarde, de ondoorlatendheid

("no flow”) is al ingevoerd door de deklaag ondoorlatend te maken. Het andere onderdeel, de

grondwatervoeding uit het neerslagoverschot, moet worden ingevoerd als een vaste voeding.

Hiertoe biedt MicroFEM twee mogelijkheden:

1. De voeding opgeven als een negatieve onttrekking (injectie) in de knooppunten van het
bovenste watervoerend pakket; de voeding per knooppunt is (lineair) evenredig met het
invloedsoppervilak dat bij elk knooppunt hoort.

2. Gebruik maken van een speciaal topsysteem.

Hoewel de eerste methode niet meer wordt aangeraden (vanwege de onjuiste berekening
van 3D-stroomlijnen), kan die in geval van bepaalde randvoorwaarden wel nuttig zijn. In ons
geval gaan we het eenvoudiger "precipitation" (neerslag) topsysteem gebruiken.

1. Klik in het hoofdmenu op Project - Project manager. Het volgende pop-up menu
verschijnt (Figuur 19):
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# Project manager =] E3

Lnit Save: Help

B aze- mn:u:lel tutu:nrlaH ferm E "-.D n:u:uments and 5E!tt|h§|$"~phl|lp"-.h"|l|r‘| dacumentenhprcqec:ten'xl‘-*l|n::rn:|FEM"~vEI 4'&

Figuur 19: Project manager dialoogvenster (1)
2. Klik op de o knop (“Add to project”). Nu verschijnt een volgend dialoogvenster (Figuur
20):

Add to:project

—&dd unit;

" Thickness

= Anizotropy ¢ Drain spstem

= Storativity  River system

" Labels = Ewaporation system

= xira work sheet = wadirecharge system
—LCreate data from:

" File o Mew

k. Cancel | Help |

Figuur 20: Program manager, “Add unit” menu

3. Selecteer "Precipitation" en zorg dat ook "New" gekozen is (zie Figuur 20).

4. Klik op de OK-knop. Het Project Manager-venster verschijnt weer. Later zullen we
uitgebreider stilstaan bij de Project Manager, controleer nu alleen even dat er inderdaad
een nieuwe “precipitation-unit" aan het modelproject is toegevoegd. Sluit nu het Project
Manager venster (dat er ongeveer zal uitzien als in Figuur 21).
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# Project manager H[=] E3

Linit Sawe Help

ﬁ|EI| ﬁ| ? |

Baze-model tutariall.fem  C:AD n:n::uments and Settmgs'&phlllphMun dacumentenhprcqec:ten"-.h*l|n::rn:|FEh-1'wEI 4'\
Precipit ation Lintitled
Modified | v

Figuur 21: Project manager dialoogvenster (2)

5. In het datavenster is nu een tabblad toegevoegd met de naam “top” (Figuur 22):

F'araml Top I
0 |head [rn] [ 0000
1 lwert res [Adin

Figuur 22: Datavenster met nieuw topsysteem

6. Klik op de nieuwe "Top" tab om de “lijst” van topsystemen te bekijken, nu nog bestaande
uit alleen “Precipitation” (Figuur 23).

Param Top |
Precipitation  [m/d] IEI.24 /365,24

Figuur 23: Topsysteem tab

7. Dubbelklik op de cel naast "Precipitation [m/d]" en voer de benodigde neerslag in,
uitgedrukt in meter per dag. Tik de formule 0.24 / 365.24 in (laat de invoer zo staan, zie

Figuur 23) en klik op de _I—knop of de F5-toets (“All nodes”). De formule is nodig omdat
het neerslagoverschot is gegeven als 240 mm per jaar, terwijl we in MicroFEM alles naar
meters en dagen moeten omrekenen.

Zijrandvoorwaarden
Nu gaan we de zijrandvoorwaarden invoeren.
De rivieren hebben een waterpeil van 35 m boven de basis van het watervoerend pakket (het
verhang in de rivieren wordt verwaarloosd). Het waterniveau in de rivieren wordt
verondersteld niet te worden beinvloed door grondwaterstroming In het modelgebied; met
andere woorden, de waterpeilen in de rivieren kunnen worden beschouwd als vaste peilen.
In modeltermen heet het dat zij als vaste randstijghoogten (“fixed head boundaries”) kunnen
worden aangehouden. De oost- en westrand van het model worden verondersteld parallel
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aan de grondwaterstromingsrichting te liggen en kunnen daarom als ondoorlatend
beschouwd worden (“no-flow boundaries”).

Het is belangrijk om te beseffen dat er voor stroming door de randen van het model twee

soorten randvoorwaarden zijn:

1 Vaste stijghoogtes (“fixed-head, ook wel “given head”, “specified head” of Dirichlet). In
zo’n geval berekent MicroFEM de randflux.

2 Vaste randflux (“specified flow”, “given flux” of Neumann). In dat geval berekent
MicroFEM de randstijghoogte. Een ondoorlatende rand (“no-flow boundary”) is een

bijzonder geval van dit type.

Voor alle knooppunten (ook de interne!) in elk watervoerend pakket moet een van deze twee
randvoorwaarden worden opgegeven. Standaard staan alle knooppunten ingesteld op type 2
(stijghoogte berekend door MicroFEM) met een standaard flux gelijk aan nul (“no-flow
boundary”). Het bovenstaande houdt in dat de westelijke en oostelijke randvoorwaarden al
goed staan ingesteld.

Waar het toekennen van hydraulische parameters (doorlaatvermogen e.d.) gemakkelijk ging,
moeten we nu de randvoorwaarden opleggen aan een deel van de knooppunten. We zullen
weer "markeringen" toepassen om dit snel en efficiént te doen.

Type randvoorwaarde voor de rivierknooppunten
Om voor de rivierknooppunten in pakket 1 vaste randstijghoogten op te geven (“fixed-head”):

1. Laten we allereerst alle bestaande markeringen verwijderen, om te vermijden dat de
vaste stijghoogten onbedoeld worden toegekend aan verkeerde knooppunten: klik op de

-knop (Delete marks) of druk op Del in Loop- of Invoermodus, en zorg vervolgens dat

het netwerk opnieuw wordt getekend door te klikken op de ___}-knop (Draw grid) of
drukken op Ins. Klik eenmaal op de Param-tab in het datavenster om de parameterlijst
zichtbaar te maken.

2. Markeer nu de rivierknooppunten. Ga naar Invoermodus (klik zonodig op de ﬁ—knop)
en klik dan op label 1 om dit de actieve parameter te maken.

3. Klik op de ﬁ-knop of druk op F2 (Mark data or labels). Een pop-up venster zoals in
Figuur 24 verschijnt. (Als hier waarden staan in plaats van labels heeft u vergeten om eerst
label 1 als actieve parameter te selecteren).

Mark: labels
0k
Enter a label:
rive Cancel
fiwed node 10
fiwed node & Help
landfill

Figuur 24: Mark data or labels dialoogvenster

4. Zorg dat de labelnaam "rivier" geselecteerd is in het pull-down menu (zie Figuur 24) en
klik op de OK knop. U zult zien dat de rivierknooppunten nu gemarkeerd zijn.

5. Klik op de cel naast "head [m]" in pakket 1 (h1).
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6. Klik op de il—knop (“Fixed heads for marked nodes”) of druk op de F9-toets om het type
randvoorwaarde van alle gemarkeerde knooppunten te veranderen: in dit geval van no-
flow (was standaard ingesteld) naar fixed-head, voor alle rivierknooppunten.

Zoals u kunt zien is nu voor de rivierknooppunten naast het woord "1 head" in de
parameterlijst het woord "fixed" verschenen, hetgeen betekent dat het actieve knooppunt een
vaste stijghoogte heeft in dit pakket.

Controle op type randvoorwaarde
Veel foute modelresultaten hangen samen met een verkeerd type randvoorwaarde dat
ergens in een model is ingevoerd. Soms kunnen die fouten maar moeilijk worden
opgespoord. Met MicroFEM is echter een eenvoudige procedure mogelijk waarmee kan
worden achterhaald waar vaste stijghoogtes (en niet-vaste) zijn opgelegd in een bepaald
pakket:

1. Ga naar de Loopmodus (klik op deﬂ—knop).
2. Verwijder alle markeringen: klik op de _i-knop (Remove all marks) of druk op Del.

3. Zorg dat de stijghoogte (head) in de bedoelde watervoerend pakket (ingeval van multi-
aquifer modellen) is geselecteerd: klik op de cel van (in dit geval) h1.
af

Ga nu naar Invoermodus: klik op de knop.

Klik op de ;'.I-knop (“Mark nodes with fixed heads”) of druk op F10. De vaste
stijghoogtes in het betreffende pakket zijn nu gemarkeerd.

6. Voor een overzicht van de gemarkeerde vaste stijghoogtes, kunt u:

a) Naar Loopmodus gaan (ﬂ-knop of Alt-1), dan klikken op de ﬂ-knop (Blink
marks) of op F6. De gemarkeerde (en dus fixed) knooppunten zullen knipperen,
meestal helpt dit bij het snel herkennen, en/of:

b) Naar Tekenmodus gaan en klikken op de !l—knop (Clear graph) of op Del

drukken, vervolgens op de _I-knop (Draw marked nodes) klikken of op F3 drukken.

Ingeval van meerdere naast elkaar gelegen vaste stijghoogten (bijvoorbeeld langs

een vaste stijghoogterand) kan gecontroleerd worden of werkelijk alle stijghoogten

vast zijn (en dus gemarkeerd) door ook de verbindi_nfslijnen tussen gemarkeerde
O

knooppunten te laten tekenen door klikken op de “=I-knop (Connect marked nodes)
of op de F4-toets te drukken. Als er één of meer knooppunten geen vaste stijghoogte
hebben, dan worden ze nu snel herkend omdat de getekende lijn niet ononderbroken
is, maar hiaten vertoont aan weerzijden van de niet-gemarkeerde knooppunten.

Waarde van de randvoorwaarde voor de rivierknooppunten

Dit is een gemakkelijke stap. We beginnen gewoon met een stijghoogte van 35 m voor alle
knooppunten. Hierbij kiezen we de basis van het watervoerend pakket dus als referentie
niveau voor de stijghoogtes. Feitelijk hoeven alleen de rivierknooppunten een vaste
stijghoogte te hebben van 35 m; de stijghoogtes in alle andere knooppunten zullen namelijk
worden berekend. Het is in dit geval echter wel gemakkelijk om dezelfde stijghoogte toe te
kennen aan alle knooppunten. De waarden die voor de stijghoogtes zullen worden berekend,
zZijn (bij stationaire stroming) onafhankelijk van de waarden bij de start van de berekening.
1. Klik op de waardecel van h1 om die te selecteren (waarschijnlijk was die al geselecteerd

bij de vorige stappen)

Klik voor alle zekerheid op de gl-knop zodat MicroFEM in Invoermodus staat
Voer een waarde van 35 in

Klik op de gl—knop (All nodes) of druk op F5.

@ N
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Klaar!

Het model (tussentijds) opslaan
Nu zijn we gereed om het model voor de eerste keer door te rekenen. Maar het is verstandig
om het eerst op te slaan.

Dat gaat simpel door in het hoofdmenu te klikken op de opdracht File > Save All.

Waarschijnlijk zult u eerst een dialoogvenster zien met de vraag waar de bestanden moeten
worden opgeslagen en onder welke bestandsnaam (zo niet dan heeft u alle gegevens al
eerder bewaard; MicroFEM heeft dan alle bestandsnamen onthouden en overschrijft dan de
betreffende bestanden op de harde schijf met de nieuwere gegevens). Navigeer zonodig
naar een geschikte(sub)map waar u de modelgegevens wilt opslaan (wellicht dezelfde map
als waar u de netwerkbestanden (.fen) heeft bewaard), bewaar daarna alle “units” die bij het
model horen, in dit geval: het basis-model (.fem-file) en de “precipitation unit” (.ppn-file).
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STAP 3: HET MODEL STATIONAIR DOORREKENEN
ZONDER PUTONTTREKKING

We zullen het model eerst stationair doorrekenen, zonder de putonttrekking, en beginnen
met het berekenen van de opbolling tussen de rivieren die het gevolg is van de
grondwatervoeding uit het neerslagoverschot en de afstroming naar de rivieren. Een
probleem dat we moeten oplossen is dat de verzadigde dikte van het watervoerend pakket
(die uiteraard afhangt van de opbolling) van te voren niet bekend is; hierdoor kunnen we het
juiste doorlaatvermogen ook niet van te voren invoeren.

Handmatige berekening van de hoogte van de
grondwaterspiegel

Zoals eerder gezegd zullen we eerst laten zien hoe freatische condities met de hand kunnen
worden berekend. Dit gaat als volgt:

a) Eerst kennen we een startwaarde voor het doorlaatvermogen toe van h1 * 12 (m?/d).
Omdat we voor alle knooppunten al een startwaarde voor de stijghoogte hebben
ingevoerd van 35 m en een eerste schatting van het doorlaatvermogen van 12 * 35 = 420
m?/d, kunnen we nu deze eerste stap overslaan. Merk op dat in dit geval de stijghoogte
h1 even groot is als de verzadigde dikte van het watervoerend pakket, omdat we als
referentieniveau de (horizontale) onderkant van het watervoerend pakket hebben
gekozen. In gevallen met minder voor de hand liggende referentieniveaus, zoals bij
hellende of discontinue bases van het watervoerend pakket of ingesloten kleilenzen, zal
de verzadigde dikte van het watervoerend pakket veel preciezer, misschien zelfs wel met
verschillende formules per knooppunt, moeten worden berekend. In de praktijk wordt
meestal NAP (Normaal Amsterdams Peil) of TAW als referentie voor alle (stijg)hoogtes
aangehouden.

b) We berekenen vervolgens de stijghoogtes gebaseerd op het geschatte doorlaat-
vermogen. Als gevolg van de opbolling zal de verzadigde dikte vooral midden tussen de
rivieren meer dan 35 m zijn. Ook het doorlaatvermogen zal hier dus het hoogst zijn.
Omdat we in eerste instantie met een te laag doorlaatvermogen rekenen (420 m?%d), zal
de berekende opbolling na de eerste berekening juist te groot zijn. De grootste fouten
treden op midden tussen de rivieren, waar de stijghoogtes het grootst zijn. Naarmate we
het doorlaatvermogen beter kennen, kunnen we de stijghoogtes nauwkeuriger
berekenen, en daarmee weer het doorlaatvermogen beter benaderen. Iteratief
(stapsgewijs) komen we tot een steeds beter oplossing. Als de hoogste stijghoogtes in
twee opeenvolgende stappen niet meer significant verschillen, zal de berekende
opbolling van de grondwaterspiegel en de daarmee berekende verzadigde dikte en
doorlaatvermogen juist berekend zijn. Zolang er echter nog duidelijke veranderingen zijn,
dient het doorlaatvermogen te worden geactualiseerd op basis van de zojuist berekende
stijghoogtes en gaan we door met stap c).

c) We voeren nieuwe waarden voor het doorlaatvermogen in; deze blijven in alle knoop-
punten lineair afhankelijk van de zojuist berekende stijghoogtes (t1 = h1 * 12), daarna
gaan we terug naar stap b).

In concreto:
Kies in het hoofdmenu Calculate - Go Calculate (Figuur 25).
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Files Project “iew Commands | Calculate Options  Tools

Options...
Edit batch-file...

Figuur 25: Calculate opdracht
Er verschijnt nu een pop-up venster als in Figuur 26:

Al Calculation of Heads

Itceration P 39
s @ 0.04913 [to)

19.00 (m3/d)

mﬂml

Figuur 26: Stationaire stijghoogte berekening

In dit venster wordt het nummer van de laatste iteratie, de daarbij behorende grootste
stijghoogteverbetering en de gemiddelde waterbalansfout getoond. Zodra MicroFEM klaar is
met de berekening, verdwijnt het venster en wordt het kaartvenster opnieuw getekend.

Vervolgens maken we een kaart van de berekende hoogte van de grondwaterspiegel
(feitelijk van de berekende stijghoogtes).

1. Ga naar Tekenmodus (klik op de &—knop). Zoom uit tot het gehele modelgebied
Zichtbaar is.

2. Kies een geschikte tekenkleur, bijvoorbeeld lichtblauw, door te klikken op een lichtblauw
JO O O
hokje in het kleurenpalet == " " M®] _ 55 de werkbalk. In dat vierkantje verschijnt

een sterretje, ten teken dat deze kleur nu voor alle volgende tekeningen zal worden
gebruikt (totdat een andere kleur wordt gekozen).

Kies als te tekenen object de stijghoogte: klik in de cel h1.

Klik op de -knop, of druk op F7, of kies in het hoofdmenu Command - Draw
contours. U ziet nu het dialoogvenster van Figuur 27:
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head:T:fmj
MirirnLrn ISE.EIEIEI oK
b airnuirn |42.I]4‘I
Cancel
|nterval Im
Hel
[ within zpecified range i

[T Innonemarked area only

Figuur 27: Isolijnen dialoogvenster (2)

In plaats van meteen door te gaan met het tekenen van isolijnen zullen we dit venster
wat meer in detail bekijken. Ten eerste laat MicroFEM hier de hoogste en laagste waarde
van alle knooppunten binnen het kaartvenster zien van de te “contouren” parameter
(35,000 respectievelijk 42,041 m). Hieruit concluderen we dat de laagste stijghoogte 35,0
m bedraagt, wat logisch is wanneer we bedenken dat alle stijghoogtes tussen de rivieren
hoger zullen moeten zijn dan de 35,0 m die is ingevoerd als vaste randstijghoogte langs
de rivieren. We zien ook dat de hoogst berekende stijghoogte (in het kaartvenster)
42,041 m bedraagt, wat impliceert dat de zojuist berekende opbolling van de
grondwaterspiegel gelijk is aan 42,041 — 35,0 = 7,041 m.

MicroFEM doet ook een suggestie voor een (redelijk) isolijneninterval (“contour interval®);
in dit geval 0,5 m.

Het staat u uiteraard vrij om hier andere gewenste waarden in te vullen bijvoorbeeld een
isolijneninterval van 0,1 m, door die waarde simpelweg in te tikken in het "Interval" veld.
U kunt de minimale en/of maximale te tekenen isolijnenwaarden beperken door voor de
minimum en maximum waarden andere getallen in te vullen (en die hoeven niet per se
precies een geheel aantal malen het isolijneninterval te bedragen).

De onderste “check box” ("In non-marked area only") dient om het tekenen van isolijnen
te beperken tot een gedeelte van het modelgebied.

5. OK, laat voor dit moment de suggesties van MicroFEM staan en klik op de OK-knop.
MicroFEM zal dan een isolijnenkaart tekenen van h1 (Figuur 28):
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Filez Project  “iew Commands Calculate Options Tools  Import Export Help

F'alaml Top |

0 [head (m] [o.oo0
1 |wert. res. [d] |O
transz. [rEAd] [ 420
head [r] (B3 1
discharge [?/d] |0

% | 1:1Es | 122 | %=434330 y =2439.70 label 1

o i [olO# ekl ERrr rrmn Sil=l | alal @l¢ 8Kl

Figuur 28: Isolijnenkaart van h1, stijghoogte in watervoerend pakket 1

Op dit moment hebben we de stijghoogte berekend in het watervoerend pakket. Het
doorlaatvermogen is echter nog overal in het model hetzelfde (420 m%d), terwijl die in
werkelijkheid lineair afhankelijk wordt verondersteld van de hoogte van de
grondwaterspiegel:

T = <verzadigde_dikte> X k.
Om een betere schatting te maken kunnen we de resultaten nu stap voor stap verbeteren:

1. We geven op dat t1 (doorlaatvermogen van watervoerend pakket 1) lineair afhankelijk is
van de zojuist berekende stijghoogtes h1. Ga naar Invoermodus, klik op de cel t1 en tik
de volgende formule in:
h1*12 (zonder spaties)

en klik op de g—knop (All nodes).

Voor alle knooppunten in het model is nu de verbeterde waarde voor t1 ingevoerd,
gebaseerd op de berekende hoogtes van de grondwaterspiegel. Deze verbeterde waarde
voor het doorlaatvermogen zal echter leiden tot andere waarden voor de berekende
stijghoogtes.

2. Herbereken het model. Kies Calculate - Go calculate in het hoofdmenu.
MicroFEM rekent nu niet alleen het model door, maar zal daarna opnieuw de
isolijnenkaart van h1 tekenen, nu gebaseerd op de zojuist opnieuw berekende
stijghoogtes.

3. Om de waarde van de hoogst-berekende stijghoogtes te achterhalen gaat u naar

Tekenmodus, selecteert u h1 in het datavenster en klikt u op de -knop (Draw
contours). Neem de hoogst berekende stijghoogte over uit het dialoogvenster (in ons
geval 41,419 m) en klik in dat dialoogvenster op de Cancel-knop.

U zult zien dat u nog een iteratie extra nodig hebt (vanaf stap 1) om uit te komen op een

maximum berekende stijghoogte van 41,448 m, ofwel een opbolling van 6,448 m boven het
waterpeil in de rivieren.
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Automatische berekening van freatische grondwaterstanden

MicroFEM modellen kunnen ook worden doorgerekend waarbij het doorlaatvermogen
automatisch wordt aangepast aan de verzadigde dikte van het freatische pakket. Hiervoor
hebben we enkele extra “units” nodig:

e Een dikte- (“thickness”) unit, waarin we een startwaarde opgeven voor de verzadigde
dikte van het freatische pakket.

o Een bergings- (“storage”) unit, waarin we een bergingcoéfficiént voor alle pakketten
opgeven. Wanneer we deze bergingcoéfficiént overal de waarde 0 geven, worden de
stijghoogtes berekend voor stationaire (“steady-state”) stroming.

¢ Een batch-file waarin we een aantal simpele opdrachten opnemen die door MicroFEM
zullen worden uitgevoerd.

Maar eerst zullen we enige administratie moeten uitvoeren: klik in het hoofdmenu op Project

- Information. Het Informatievenster verschijnt. Laat de modelnaam maar staan op tutorial1

maar zet wel een opmerking bij "Remarks” om aan te geven dat dit model gediend heeft voor
handmatige berekeningen van de grondwaterspiegel (bijvoorbeeld zoiets als in Figuur 29):

Project Information |
Mumber of nodez . 2415 Last update 13-04-03
Murber of elements : 4652 Prezent date 18-04-03
kodel name tutariall
Froject MicroFER turonal
Location zomemhere
D ate zome hime
Remarkz M arual zalculation of unconfined zaturated thickness

kMound height turned out to be 471448 m
|

Figuur 29: Voorbeeld van bijgewerkt Informatievenster

Zodra u de veranderingen hebt ingevoerd en op de OK-knop heeft geklikt, kunt u het model
en alle units opslaan (File > Save all).

Vervolgens zetten we alle berekende waarden voor de stijghoogtes en doorlaatvermogens
terug op de uitgangssituatie. Voer een stijghoogte van 35 m en een transmissiviteit van 420
m?/d in voor alle knooppunten. Voor u verder gaat dient u bij “‘Remarks” in het Informatie-
venster aan te geven dat het model nu dient voor automatische aanpassing van de
verzadigde dikte en bijbehorend doorlaatvermogen: Verander de inhoud van het Model
Name-veld in tutorial2. Daarna bewaren we het model met andere namen voor alle units, om
dit model te onderscheiden van het voorgaande:

Klik in het hoofdmenu op Project - Project manager. Kies in het dialoogvenster eerst het

fpr-bestand ("project file") door hier eenmaal op te klikken. Klik dan op de .El_i-knop en geef
in het volgende bestandsvenster tutorial2 op als bestandsnaam laat het type bestand,
"Project file (*.fpr)", ongemoeid). Klik in het Project manager-venster op Base model en sla
dit op met dezelfde bestandsnaam (tutorial2) als het projectbestand.

In principe hoeft de naam van de neerslag- ("precipitation”) unit niet per se te worden
aangepast zolang als noch het eindige-elementennetwerk noch de hoeveelheid neerslag
verandert (beide modellen, tutorial1 en tutorial2, gebruiken dus dezelfde unit).
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Nu de voorbereidende acties voor de volgende berekening klaar zijn, zullen we de zaken
toevoegen die nodig zijn voor het automatisch rekenen met freatische condities:

1. Kies in het hoofdmenu Project > Project manager. In het dialoogvenster (Figuur 21) klikt

uopde Eﬁ.l-knop en in het volgende venster (Figuur 20) kiest u "Thickness" en "New";
klik dan op “OK”.

2. Klik nogmaals op de El-knop in het Project manager venster en kies in het volgende

venster (Figuur 20) "Storativity" en "New""; klik dan weer op “OK”.

3. Sluit nu het Project Manager venster. In het MicroFEM datavenster zijn twee nieuwe
tabjes toegevoegd. Klik op de "Thick"-tab om de lijst met pakketdiktes weer te geven:

Faram Thiﬂkl Stor I Top I

0 [top level [rn] {0.000
1 |aguitard [rn] j 0000

aquifer [rn] 111

Figuur 30: Nieuwe Thickness tab

4. In een freatisch model is aan de bovenzijde geen “aquitard” (slechtdoorlatende deklaag)
aanwezig. Het volstaat om hier de dikte van 0 m te laten staan. We moeten wel een
(start)waarde opgeven voor de dikte van het pakket. Bij een doorlaatvermogen van 420
m?/d, zoals reeds ingevoerd, hoort een verzadigde dikte van 35 m voor alle knooppunten
(Figuur 30).

5. Vervolgens voeren we een startwaarde in voor het “top level”, dat is de bovenkant van de
verzadigde zone van het gehele model ten opzichte van het referentieniveau. Omdat we
ervoor hebben gekozen om het referentieniveau aan de basis van het watervoerend
pakket te leggen, en we voor de dikte van het pakket 35 m hebben ingevoerd, moet het
“top level” hier ook 35 m zijn voor alle knooppunten.

6. Klik dan op de "Stor"-tab. MicroFEM rekent alleen met berging(sveranderingen) in de
watervoerende pakketten. Omdat er maar één pakket is in dit model, is er ook maar één
invoerpositie in de “storativity unit’. Hoewel de bergingscoéfficiénten van een nieuwe
“unit” standaard op nul staan, zullen we deze toch invoeren (al is het maar voor de

zekerheid). Klik op het storativity-veld, voer "0" (nul) in en druk op F5 of klik op de g—
knop. Klik vervolgens op de "Param"-tab om terug te keren tot de stijghoogte-informatie.

We zijn nu klaar met invoeren van extra parameters. Het is belangrijk te beseffen dat voor
“head”, “transmissivity”, “aquifer thickness” en “top level” in alle knooppunten met elkaar
overeenstemmende waarden zijn ingevoerd. We hebben voor de start van de berekening de
grondwaterspiegel overal op 35 m gelegd, en hieruit volgen de waarden voor het
doorlaatvermogen, de dikte en de top van het model. We moeten nu nog opgeven hoe de

berekening van de stijghoogten moet worden uitgevoerd.

7. Kies in het hoofdmenu Calculate - Options. Er verschijnt een venster waarvan het
linkerdeel eruit ziet als Figuur 31:
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4l calculation options

Optians | Batchfie editor |

{~ Transient

[~ Bhreatic top aguiter

[~ Undo enabled

Hhdm lash ealzulation |

[~ Saveogfilz

Calculate | E:-l El

Figuur 31: Linkerzijde van het Calculate-venster (1)

Het "Phreatic top aquifer" check box gedeelte is nog grijs. Om hier bij te kunnen moeten
we eerst een batchfile maken, een zogenaamde .feb-file of MicroFEM batch-bestand.

8. Kilik op de "Batch-file editor"-tab. In het Calculate-venster verschijnt een eenvoudige
teksteditor (Figuur 32):

e

Options  Batchfile editor |
RINITES
STEPS
FACTOR
SETMIMUTES
SETDAYS
SETYEARS

Calculate | %l El Ok, Cancel Help

Figuur 32: Batch-file editor (1)

Het linkerdeel (blauwe achtergrond) is eigenlijk een simpele ASCII teksteditor waarmee
alle standaard bewerkingen kunnen worden uitgevoerd (behalve vormgeving). In het
rechterdeel staan twee kolommen met de namen van allerlei mogelijke opdrachten.
We moeten de volgende instructies invoeren:

TIME DAYS=1 STEPS=5
RUN
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Op de eerste regel specificeren we een gesimuleerde periode van één dag (“stress period”),
opgedeeld in vijf gelijke tijdstappen (“time steps”; elke tijdstap zal straks overeenkomen met
één van onze handmatige iteraties). Het volgende commando (RUN) vertelt MicroFEM
eenvoudig om het model voor de opgegeven periode door te rekenen.

We kunnen dit gewoon intikken; maar we kunnen ook eerst dubbelklikken op het woord
TIME in de linkerlijst, dan dubbelklikken op het woord DAYS in de rechterlijst (DAYS=
verschijnt dan) en met de hand 1 intikken (voor het aantal dagen dat zal worden
gesimuleerd), en vervolgens dubbelklikken op STEPS (STEPS= verschijnt) en met de
hand 5 intikken (het aantal tijdstappen waarin de periode wordt opgedeeld).

N.B.: Omdat de berging overal in het model gelijk is aan nul, werken we hier met een
stationair model en daarom is de gesimuleerde tijd (“stress period”) feitelijk van geen
belang — we hadden evengoed één seconde of duizend jaar kunnen opgeven. Bij het
rekenen zal MicroFEM voor het eind van elke tijdstap de stijghoogte- (grondwaterstands)
veranderingen berekenen, en daarmee de doorlaatvermogens, pakketdikte en “top level”
corrigeren. Bij de handmatige berekening hebben we gemerkt dat minimaal drie stappen
nodig zijn; in dit geval nemen we er voor de zekerheid vijf. (Per slot van rekening doet
MicroFEM nu het werk voor ons, dus een beetje extra rekenwerk maakt ons niet veel uit).
In complexere modellen, vooral in geval van meerdere watervoerende pakketten, kunnen
echter veel meer tijdstappen nodig zijn.

We sluiten af met de opdracht END. De tekst van de batchfile komt er dan uit te zien als
Figuur 33:

STEPS=5

RUN
END

Figuur 33: Complete batch-file (1)

De lay-out van MicroFEM'’s batchbestanden doet er niet toe; de volgorde van de
opdrachten is echter essentieel. Zorg dat de bovenstaande batchfile in het geheugen
wordt opgeslagen door te klikken op de “OK”-knop.

Veel meer informatie over MicroFEM batch-bestanden vindt u in de On-line Help.

9. Kilik nu op de Options-tab. De "Phreatic top aquifer"-optie is niet meer grijs; plaats een

vinkje in het vakje (Figuur 34), klik dan op de OK-knop. Laat de andere velden en
keuzemogelijkheden staan zoals ze zijn.

December 2010 42 van 68



MicroFEM handleiding versie 4.10

ol

Options | Batch-fie editar |

{" Steady state

Fimimum iterations |20

@ T M axirnum terations 5000

7 Bt wia Belaxation factar |0
W It
DS e cIL sk Epen & liz=dhs 0.onm

Water balance erar [0

[~ Undo enabled

Wnda |zt calculation

[~ Save log file

Eglculatel E‘;l El ok I Cancel | Help

Figuur 34: Calculate venster (2)

10. Voor we verder gaan is het verstandig om het project op te slaan (File > Save all in

11.

12.

hoofdmenu). MicroFEM zal om namen vragen voor de nieuw gemaakte dikte- en
bergingsbestanden en voor het batchbestand.

Ga naar de Tekenmodus (&), kies vervolgens in het hoofdmenu Calculate - Options
en klik dan op de Calculate-knop. Een zwart pop-up venster komt te voorschijn
(“Calculation of heads”) met informatie over de voortgang van de berekeningen. Klik op
de Stop-knop wanneer de berekeningen klaar zijn. Klik daarna op de OK-knop om het
Calculation venster te laten verdwijnen. De isolijnenkaart van de grondwaterspiegel wordt
opnieuw getekend.

Controleer de berekende hoogste grondwaterstand met de -knop. Zelf vonden wij een
maximum waarde van 41,448 m, precies hetzelfde als bij de berekening met de
handmatig aangepaste KD-waarden.

Tekenen van een stijghoogteprofiel en een dwarsdoorsnede

Om een goed beeld te krijgen van de opbolling van de grondwaterspiegel en de verzadigde
dikte van het watervoerend pakket kunnen we ook stijghoogteprofielen en dwarsdoorsneden
tekenen.

1.

Ga naar de Tekenmodus (als dat nog niet het geval was) en klik op de Zi:knop (rechts
van het kleurenpalet), of druk op F10, of kies in het hoofdmenu Commands - Select
profile. Er verschijnt nu een lijn op het kaartvenster. Klik eerst met de linkermuisknop
ergens op de noordgrens van het model, vervolgens met de rechtermuisknop ergens op
de zuidgrens van het model. Op deze manier kunt u zowel de ligging van het stijghoogte-
profiel als van de dwarsdoorsnede kiezen (Figuur 35):
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Filez Project “iew Command: Calculate Option: Tool:  Import Export Help

Param | Thick | Ster | Tep |

.............................................. — 1 6.00¢
1 | wert. res. [d] |0

trans. [reéAd] |452.6

head [r] [41.048
dizcharge [wé/d] |0

276 | 1015 | 433 | %=-443.23 y=-1289.28
@(m| 3 |olOslel: ERr e r e

x| &||

Figuur 35: Vastleggen van de positie van stijghoogteprofiel en dwarsdoorsnede

2. Wanneer u wilt voorkomen dat de ligging van de dwarsdoorsnede en het stijghoogte-
profiel per ongeluk verandert door latere muisklikken in het kaartvenster, dan kunt u nu

nogmaals op de i knop klikken (of op F10 drukken of in het hoofdmenu de optie
Select profile-option uitvinken); de lijn die de positie van de dwarsdoorsnede aangeeft,
verdwijnt dan.

3. Klik op de g-knop of druk op F11 (of kies eventueel Command - Draw profile in het
hoofdmenu). Er verschijnt nu een grafiek met het profiel van het stijghoogteverloop op
een zwarte achtergrond.

4. Klik op de g—knop of druk op F12 (of kies eventueel Command - Draw section in het
hoofdmenu). Er verschijnt dan een tweede grafiek, nu van een dwarsdoorsnede door het
model, eveneens op een zwarte achtergrond.

5. Om te bezuinigen op zwarte inkt (toner) is in Figuur 38 een witte achtergrond en een
zwart assenstelsel ingesteld. Kies hiertoe in het hoofdmenu Options - Profile... en dan
het tabblad Colors. In het dialoogvenster kiest u dan met behulp van de drop-down lijsten
wit voor de achtergrond en zwart voor de assen. In het voorbeeld van Figuur 38 stond de
kleur van h1 ingesteld op blauw, hiertoe was eerst geklikt op Head 1 (rechts) en toen op
het blauwe hokje in het kleurenpalet links (Figuur 36):
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Profile Options |

Crale  Caolars |

—color of head

[ ] HeadD
Head 1

~Background color—————— |'.-'1‘-.:-ces colo

[ — 1 | I -

0k, Cancel | Help

Figuur 36: Venster met kleuren-opties voor stijghoogteprofielen

6. Ook het venster voor dwarsdoorsneden (rechts-boven in Figuur 38) is aangepast voor
wat betreft de kleuren. Kies in het hoofdmenu Options = Section... en dan Colors. Door
met de linkermuisknop te klikken in het kleurenpalet kiest u de kleur voor watervoerende
pakketten, met de rechtermuisknop de kleur voor slechtdoorlatende lagen. Hiernaast
biedt de Layers tab nog wat aanvullende mogelijkheden (patronen enz.) om
dwarsdoorsneden verder op te leuken (Figuur 37):

Section Options |

Scale I Colors  Layers | F|DW|inEI

—Aquifer brush patterr Layers——
f* Solid i Left hatched

LppEr: |1 3’
" Clear i~ Right hatched
" Horizortal ine € Cross lowver. I-I Ev
" Yerlical line i~ Diagonal cross

—Aquitard brush pattern

= Salid = Left hatched
" Clear i~ Right hatched
" Haonzontal ine ) Cross

" Yerlical line i [iagonal cross

Cancel Help

Figuur 37: Venster met opties voor dwarsdoorsneden

7. Op het Scale tabblad kunnen nog meer zaken worden ingesteld, zoals automatische
danwel handmatig ingestelde verschaling, intervallen, enz. Om de gekozen instellingen
voor volgende tekenacties te bewaren, kunt u ze opslaan door Options - Save settings
in het hoofdmenu te kiezen.
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Het stijghoogteprofiel, de dwarsdoorsnede en het MicroFEM venster zien er uit als Figuur 38:

4 Prafile M=l B3l 4 section [ [O]

a0
40
30
20
10

n
o T T T T T T )
0 1E3  ZE3  3E3 4E3  BE3Z  BE3  VE3

a0
40
30
20

Lo

.

e o S e S it
L S S P L R
s
e R
bttt b gt b
e S s L bt

1E3 2E3 3E3 4E3 FE3 EE3 TE3
| 4| Y
Faram [Thick [ Stor [ Top |
........... —— =1 0.000
""" 1 |wer res. [d] |0
tranz. [reéfd] | 4592.6
head [m] |41.048
discharge [ré/d] [0
276 | 1:1E5 | 1591 || #=11034.02 »=439933 label 1
ol | (ool ERr e AR ®|

Figuur 38: MicroFEM venster met stijghoogteprofiel en dwarsdoorsnede

Tekenen van 3D aanzichten van stijghoogteviakken en lagen

Vanaf MicroFEM versie 3.60.34 is een 3D-viewer ingebouwd. Hiermee kunnen

perspectivische 3D aanzichten worden getekend van bijvoorbeeld piezometrische viakken,
hydrologische opbouw, putfilters en stroomlijnen. We zullen deze viewer gebruiken om het
stijghoogtevlak (piezometrisch vlak van h1) te bekijken.
Kies in MicroFEM’s hoofdmenu Tools - 3D Viewer. Een venster als Figuur 39 verschijnt:
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M 3D viewer =10] x|

Show Tools Export Help

B+ = &l

Wiewye point x,y,2: -1818,-19727,115 m ‘Vert. exaggeration: 121 | &

Figuur 39: Nieuw 3D Viewer venster

In Figuur 39 is het volgende te zien:

Een rode “bounding box”. Dit is de kleinste blokvormige omlijning die nog net rond het
model past, waarbij de zijden evenwijdig aan het x-y-z codrdinatensysteem van het
model liggen

Drie coodrdinaat-assen, blauw (Y-as, N-Z), rood (X-as, O-W) en groen (Z-as, verticaal)
Een gekromd geel oppervlak; dit is het vlak van h1, de stijghoogte in pakket 1

Een plat groen vlak, dat staat voor het vlak van hO.

Een aantal simpele acties kan worden uitgevoerd met de muiscursor en enkele toetsen:

YV VYV ¥V VV V V

Roteren van het model rond de Z-as (horizontaal slepen met de linkermuisknop: houd de
linkermuisknop ingedrukt en verschuif de muiscursor horizontaal)

Voor- en achteroverdraaien (“kiepen”) van het model rond een horizontale as die
evenwijdig ligt aan het computerscherm (verticaal slepen met de linkermuisknop)

Een combinatie van roteren rond de Z-as en kiepen

Inzoomen (sleep verticaal met de rechtermuisknop); inzoomen geschiedt altijd op het
deel van het model dat precies midden in het 3D-viewer venster ligt

Aanpassen van de verticale overdrijving (verticaal slepen met de linkermuisknop terwijl
de Ctrl-toets ingedrukt wordt gehouden)

Aanpassen van de perspectivische overdrijving (verticaal slepen met de rechtermuisknop
terwijl de Shift-toets ingedrukt wordt gehouden)

“Pannen”, ofwel het plaatje horizontaal en/of verticaal verschuiven binnen het 3D-viewer
venster zodat ingezoomd kan worden op een ander deel van het model (verticaal slepen
met de linkermuisknop met ingedrukte Shift-toets).

Berekenen van waterbalansen van het model

Waterbalansen vormen een heel krachtige manier om fouten in een model op te sporen. Met
MicroFEM is het daarom erg eenvoudig gemaakt om waterbalansen op te stellen. Eerst
zullen we de waterbalans van het gehele model bekijken; later zullen we waterbalansen voor
delen van het model laten berekenen.
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Ga naar de Loopmodus en klik op de "_I"l-knop (Water balance all nodes), of druk op F5, of
kies Command - Waterbalance all nodes uit het hoofdmenu. Dat is alles wat nodig is voor
een waterbalans van een compleet stationair model.

Na een korte tijd verschijnt het waterbalansvenster (Figuur 40):

{0
X Tatal Area : BO000000.00 ré
E _?I Flaw uritz : méfdan
Il I O uitflos I Irn - Cluat I

Precipitatian 394261 394261

Sum topsystems 394261 394261
Leakage

1 Lateral fow
Boundary flow 39424.8 -39424.8
Wl Flow
Total [error) 94261 39424.8 1.4

Figuur 40: Waterbalansvenster (1)

In Figuur 40 vallen de volgende zaken te onderscheiden:

o Drie kolommen met achtereenvolgens: “Inflow” (instroming/voeding), “Outflow”
(uitstroming/drainage) en “In - Out” (verschil), alledrie gesommeerd over alle
knooppunten waarvoor de waterbalans is opgesteld (in dit geval het gehele model).

¢ De bovenste rij(-en) bevatten de waterbalansen voor elke individueel topsysteem en de
som van de waterbalansen van alle aanwezige topsystemen.

o “Leakage” (lek) slaat op de verticale stroming door de bovengelegen slechtdoorlatende
laag: “Inflow” is hier dus een neerwaartse stroming. Wij hebben in ons geval de
slechtdoolatende deklaag ondoorlatend gemaakt (zie pagina 21), zodat alle waarden
voor leakage nul zijn. Nulwaarden worden niet in de balans weergegeven.

e ‘“Lateral flow” (zijwaartse stroming) heeft betrekking op alle stroming die horizontaal in of
uit het waterbalansgebied stroomt, met uitzondering van stroming over modelranden.

o “Boundary flow” (randstroming) betreft alle grondwaterstroming die zijwaarts in of uit het
model stroomt tengevolge van vaste stijghoogtes. Let op: dit kan ook betrekking hebben
op vaste stijghoogtes binnen het model!

e “Well flow” (putstroming) houdt alle stroming in die via onttrekkingen (“discharge”) is
ingevoerd.

o “Total” geeft alle termen van de in- en/of uitstroming samen. De som van de totale
instroming en uitstroming geeft per watervoerend pakket de “error” (waterbalansfout).
Deze fout kan eventueel worden verkleind door de berekening nauwkeuriger (met meer
iteraties) uit te voeren.

Als u nu naar Figuur 40 kijkt, zult u zich misschien afvragen: “Waar vind ik nu de stroming
over de noord- en zuidrand van het model?"

Omdat dit vaste stijghoogteranden zijn, staan ze vermeld bij “Boundary flow". Volgens
bovenstaande uitleg is “lateral flow” per definitie nul voor waterbalansen van een geheel
model en dus alleen van belang als waterbalansen van een deel van een model worden
opgesteld.

Voorbereidingen voor het berekenen van het effect van de put

Teneinde de invloed van de putonttrekking te kunnen berekenen en visualiseren (hetgeen in
een volgende stap gebeurt) moeten we eerst een aantal minder voor de hand liggende
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zaken voorbereiden. We moeten allereerst de berekende stijghoogtes (grondwaterstanden)
ergens veilig opslaan om ze later te kunnen vergelijken met de berekende stijghoogten voor
een situatie met putonttrekking.

Omdat we hier te maken hebben met een freatische bovenrand, kunnen we de effecten van
de putonttrekking niet in superpositie berekenen. We zullen echt twee individuele situaties
moeten vergelijken.

Met MicroFEM zijn er twee manieren om de grondwaterstanden op te slaan:
1. Parameter bestanden en
2. Xtra Worksheet.

Met parameterbestanden

Dit is de “traditionele” manier om tussenresultaten op te slaan. Behalve voor het bewaren
van resultaten om er later mee te kunnen vergelijken, worden parameterbestanden ook
gebruikt voor het aanmaken van vele databestanden die nodig (kunnen) zijn in ingewikkelde
(vaak niet-stationaire) modelleringen met complexe topsystemen, tijdsafhankelijke
randvoorwaarden, enz.

Voor dit moment houden we het simpel en slaan we de berekende grondwaterstanden op in
een parameterbestand:

1. Ga naar Invoermodus en selecteer h1 als actieve parameter (een keer klikken op een h1-
waarde volstaat).

2. Klik in de werkbalk onderaan het MicroFEM-venster op de El-knop, of druk op F12, of
kies Command - Save parameter file uit het hoofdmenu. Er verschijnt een bestands-
dialoogvenster (Figuur 41), laat het bestandstype op “Parameter file” staan en geef een
geschikte naam op. MicroFEM suggereert een standaardnaam die bestaat uit de naam
van het modelproject en een extensie die afhangt van het type parameter (kijk in de On-
line help voor een overzicht van bestandsnaamextensies).

Save a Parameter File |

Save in: [ 3 MicroFEM - =i
1 Html

w02

10 3

tutarial2 k1

File name: Save I
Save as type: | Parameter file =] Cancel |

Figuur 41: Parameterbestand venster

3. Klik dan op de "Save"-knop.

Dit is vooralsnog voldoende voorbereiding. We zullen dit parameterbestand straks gebruiken
nadat we de grondwaterstanden opnieuw hebben berekend met de putonttrekking.
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Met het Xtra worksheet

Het MicroFEM “worksheet” (rekenblad) lijkt op een combinatie van een kladblok en een
spreadsheet. Het bestaat uit een aantal “lagen” van waardecellen, met in elke laag één cel
voor elk knooppunt. Deze lagen hebben niets te maken met de geohydrologische opbouw of
de lagen van het model; ze dienen alleen voor het opslaan van allerlei numerieke gegevens
en tussenresultaten die aan de knooppunten van het model zijn gekoppeld.

Eerst zullen we een worksheet aan ons model toevoegen:

1. Kies Project - Project Manager uit het hoofdmenu, klik op de El—knop, selecteer "Xtra
worksheet", klik op de “New” keuzeknop in het volgende venster en klik op “OK”.
Accepteer het voorgestelde aantal van 12 registers en klik op OK.

x

Mumber of registers |12 -
Cancel |

Figuur 42: Aantal lagen Xtra worksheet

Bij grotere modellen wordt een groter aantal registers voorgesteld. Het is trouwens
simpel om later extra registers toe te voegen (kijk hiervoor in de On-line Help).

2. Sluit het Project manager venster. In MicroFEM’s datavenster is weer een nieuw tabje
verschenen ("Xtra"). Klik er op, u ziet een beeld als Figuur 43:

3. Links is er een kolom met ruimte voor registernamen, die door de gebruiker kunnen
worden opgegeven. De registers hebben de codes x1 t/m x12. We zullen nu een register
gaan gebruiken om onze h1-waarden op te slaan en als geheugensteuntje zullen we
gelijk de naam veranderen:

4. Zorg dat u in Invoermode bent. Klik met de rechtermuisknop op de code “x1” of het nog
lege tekstgedeelte (...) daarnaast; tik de naam “h1 zonder put” of "h1 w/o well" in (zonder
aanhalingstekens) en klik op de OK-knop of druk op Enter.

Param| Thick | Stor | Top  Xta |

Wl
T T - M-

Enter a regizter name E I_

Reqizter name of «1
Ii —
QK I Cancel

Figuur 43: Xtra worksheet tab
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5. Klik dan op de waardecel van x1, druk op Enter, tik alleen “h1” in (weer zonder

aanhalingstekens) en klik op de Ql—knop (All nodes). Nu zijn (met behulp van de uiterst
korte formule: h1) alle h1-waarden (van het model zonder putonttrekking) gekopieerd
naar het x1- register (Figuur 44):

F'araml Thiu:kl Star I Top  #ira |

—

w1 | bl owdioowel

w2l ..
Figuur 44: h1-waarden opgeslagen in register 1
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STAP 4: STATIONAIR DOORREKENEN VAN HET MODEL
MET EEN PUTONTTREKKING

We zullen nu de putonttrekking invoeren en de grondwaterstanden opnieuw berekenen.

1.

Sluit de dwarsdoorsnede- en stijghoogteprofielvensters en klik op het g1-veld
(onttrekking) in de Param-lijst om die actief te maken.

Ga nu naar de Loopmodus. Klik op de '_"'I-knop (“Jump to node”), selecteer in het
dialoogvenster "Next label", selecteer dan de labelnaam "well" en klik op de Jump-knop;
sluit vervolgens het "Jump to node" dialoogvenster. De cursor staat nu in het knooppunt
van de put, de onttrekking in watervoerend pakket 1 is nu de actieve parameter.

Ga terug naar Invoermodus. Druk op de Enter-toets om de waarde van de onttrekking te
bewerken, voer een onttrekking van 8000 m%d in en druk weer op de Enter-toets om die
waarde alléén aan het huidige knooppunt toe te kennen. De putonttrekking is hiermee
ingevoerd. Controleer vervolgens in het Calculation options-venster (via hoofdmenu) dat
er een vinkje staat naast “Phreatic top aquifer”. Laat het model nu doorrekenen (klik op
de Calculate-knop). Klik op de “Stop”-knop en de “OK”-knop zodra de berekeningen klaar
zZijn en ga dan naar Tekenmode. De isolijnenkaart (isohypsenkaart) wordt nu opnieuw
getekend, en laat duidelijk de invloed van de putonttrekking zien. Dat is alles! De nieuwe
situatie met de putstroming is nu berekend.

Eerst zullen we het kaartvenster een beetje duidelijker maken.

Om de hinderlijke effecten van de knooppunten op het plaatje weg te nemen zullen we
die knooppunten weglaten. Kies Options > Map... uit het hoofdmenu. In het
dialoogvenster (Figuur 45) staat een lijst met de getekende componenten, de kleuren
waarin ze zijn getekend en (voor zover van toepassing) het isolijneninterval. Met de
knoppen rechts op het venster kan de tekenvolgorde van alle componenten worden
aangepast; ze kunnen tijdelijk niet worden getekend (inactief gemaakt) door het vinkje
weg te halen of met de “Delete-knop” definitief uit de lijst worden verwijderd. Voor dit
moment is het selecteren van "Node points" en het verwijderen van het vinkje voor die
naam (door er op te klikken of op de spatiebalk te drukken) genoeg; klik daarna op de
“OK”-knop.
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Al Map options [ x|

Drawing mode |.-’-'-.Iter-gri|:| mu:u:lel Colars I

Drawing components
B& head 1 [m] b Move up
Mode points
ﬁ f e dor
X Delete
k. Cancel Help |

Figuur 45: Map options venster

EEIIIII_I_I_
Om de modelrand met zwart te laten tekenen klikt u in het kleurenpalet = 8=~ =W -—

op het zwarte hokje en dan op de Ql—knop of druk op de F5-key (Teken modelrand,
“Draw boundary”).

5. We willen ook een dwarsdoorsnede en stijghoogteprofiel tussen de stortplaats en de put
tekenen. Om die laatste twee duidelijk zichtbaar te maken gebruiken we een klein trucje.
In het Xtra worksheet brengen we enkele "markeringen" aan. Ga naar Invoermodus, kies
de Xtra-tab. Spring naar de put en voer een of andere waarde in, bijv. 10 in x2. Spring nu
naar het knooppunt van de stortplaats en geef daar dezelfde waarde op in het x2-
register. Laat dan een isolijnenkaart van x2 tekenen in een contrasterende kleur, bijv.
rood.

De uiteindelijke kaart zal er dan uitzien als in Figuur 46:

Figuur 46: Isolijnenkaart van berekende grondwaterstanden met putonttrekking

De rode plekken in Figuur 45 hebben een verschillende grootte, dit hangt samen met de
verschillende elementgrootte rond die knooppunten. Om rode cirkels met dezelfde grootte te
verkrijgen drukt u in tekenmode op F8 (“Draw vectors or circles”), zet de grootte op 10, een
vinkje bij “draw discs” en klikt op de OK-knop.
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Klik nu nogmaals op de ::

versie 4.10

-knop (“Select profile”) om de dwarsdoorsnede zo te leggen

dat het ene einde op de noordrand van het model ligt en het andere eind op de zuidrand,

en het profiel zowel over de stortplaats als

rechtermuisknop = rechteruiteinde). Klik nu weer op de ::

de put loopt (linkermuisknop = linkeruiteinde,
ii-knop (profiellijn verdwijnt),

open een stijghoogteprofiel en een dwarsdoorsnede en bekijk de plaatjes (Figuur 47).

d Profile
407

IS[=1E3

T T T T T T T T
1E3  Z2E3  3EZ 4E3 BEZ  BEZ  YE3Z EE3

A Section =13
40

e
an SR e
§XX&KKX&KXXXW

o O
ﬁxxxxxxxxxxxx
%ﬁﬁﬁﬁﬁﬁ

Figuur 47: Stijghoogteprofiel en dwarsdoorsnede over de put

Om de grondwaterspiegel in 3D te zien kunt u

in het hoofdmenu Tools = 3D Viewer kiezen.

U ziet dan het gekromde oppervlak van de grondwaterspiegel met een duidelijke

onttrekkingkegel rond de put (Figuur 48).

# 3D viewer

Show Tools Export Help

5~ 2| &l

=10l x|

|View point x,y,2: -5243,-14251,64 m

‘Vert. exaggeration: 123 ‘

4

Figuur 48: 3D aanzicht van de grondwaterspiegel met onttrekkingskegel
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Om het puftfilter ook zichtbaar te maken, zoals in Figuur 48, kiest u Tools > Options in het

3D viewer menu of klikt u op de -knop. Het 3D-Viewer Options menu verschijnt. Klik op
de Wells tab om een venster als in Figuur 49 te openen.

3D viewer Options =10l x|

Wi I Genmetl_l,ll Lquifers  ells |Heads| Elowlinesl Extra I

| o W

Select all | Clear all

N | o |

Figuur 49: 3D Viewer Options menu (Wells tab)

Klik op het blauwe vierkantje naast “1971” (dat is het knooppuntnummer van de put in ons
model; in uw geval kan dat een ander getal zijn) om daar een vinkje te plaatsen en —indien
gewenst- kies een kleur voor de put door op een geschikte kleur in het kleurenpalet rechts te
klikken.
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STAP 5: BEREKENEN VAN DE INVLOED VAN DE
PUTONTTREKKING

De invloed van de putonttrekking in termen van grondwaterstandsverlagingen kunnen
worden berekend door de berekende grondwaterstanden in de situatie met putonttrekking af
te trekken van de grondwaterstanden in de situatie zonder putonttrekking.

We zullen twee methoden gebruiken om deze berekening uit te voeren:
a) Met opslaan en inlezen van parameterbestanden
b) Met gebruik van het Xtra worksheet.

Met parameterbestanden

Om het parameterbestand van h1 (dat we hebben gemaakt tegen het eind van stap 3) in te
lezen dienen we eerst een parameter te vinden in het huidige model, die voor de
berekeningen niet nodig is.

Omdat we het potentiaalafhankelijke topsysteem via een slechtdoorlatende deklaag hebben
uitgezet, zal MicroFEM niets doen met de waarden in h0. Dit is dus een geschikte kandidaat-
parameter om het h1-parameterbestand in te lezen.

Zorg dat MicroFEM in Invoermodus staat. Klik dan op hO om die te selecteren.

2. Klik op de g—knop of druk op F11 of kies Command, Read parameter file uit het
hoofdmenu.

3. Selecteer In het bestandsdialoogvenster dat volgt het bestand tutorial2.h1 (of hoe u dat
bestand ook genoemd heeft) dat we in stap 3 (pagina 49) hebben gemaakt en klik op de
"Read"-knop.

De eerder berekende grondwaterstanden zonder putonttrekking zitten nu in h0. Om de
invioed van de putonttrekking zelf uit te rekenen, moeten we nu het verschil bepalen tussen
de berekende grondwaterstanden in beide situaties.

4. Klik eenmaal op de hO waardecel en druk op Enter.

5. Tik de volgende formule in: p-h1 en druk op F5. Deze formule betekent: trek de waarde
van h1 (berekende grondwaterstand met putonttrekking) af van de huidige waarde
(“present value”) in hO; daarin zit de berekende grondwaterstand zonder putonttrekking.

6. De berekende grondwaterstandverlagingen ten gevolge van de putonttrekking zitten nu in
hO en daar kunnen gemakkelijk isolijnenkaarten van worden getekend:

7. Ga naar Tekenmodus en controleer dat hO nog geselecteerd is. Klik op het groene hokje

in het kleurenpalet (isolijnen zullen nu in groen worden getekend). Klik dan op de -
knop, kies een isolijneninterval van 1 m in het dialoogvenster en klik op de OK-knop (of
druk op Enter). U ziet dan een isolijnenkaart als in Figuur 50:

De bovenbeschreven methode is een goed voorbeeld van het gebruik van parameter-
bestanden en laat tevens zien dat MicroFEM hier en daar voor de gek kan worden gehouden
door op bepaalde plaatsen waarden in te lezen die daarvoor eigenlijk niet zijn bedoeld.
Niettemin wordt de hierna beschreven methode aangeraden. Het gebruikt de Xtra worksheet
dat juist bedoeld is om allerlei waarden in knooppunten te manipuleren zonder het eigenlijke
grondwaterstromingsmodel aan te tasten.

December 2010 56 van 68



MicroFEM handleiding versie 4.10

Figuur 50: Berekende grondwaterstandsverlagingen (groen)

Met het Xtra worksheet

Met deze methode gebruiken we de eerder berekende grondwaterstanden die zijn
opgeslagen in het x1-register (“h1 w/o well”). We doen dit als volgt:
Ga naar Invoermodus en klik op de Xtra tab. Klik met de rechtermuisknop op de derde rij
(x3; ter herinnering, in x2 hebben we de markeringen van de stortplaats en de put opge-
slagen) en hernoemen het x3-register naar "verlagingen" (zonder aanhalingstekens).

2. Kilik in de x3-cel en tik deze formule in: x1-h1 en druk op de F5-toets. De berekende
verlagingen zitten nu in register x3.

Merk op dat "x3" een parametercode is die wordt herkend door MicroFEM. In formules kunt u
alleen de parametercodes gebruiken, niet de namen die u aan de registers gegeven heeft.
Kijk onder “parameter codes” (met spatie) in de On-line Help voor een volledig overzicht van
parametercodes.

3. Om een isolijnenkaart te laten tekenen: Ga naar Tekenrmodus, klik op het groene hokje

in het kleurenpalet en dan op de -knop. Geef een isolijneninterval op van 1 m en druk
op Enter. Het resultaat moet het zelfde zijn als in Figuur 50.
Om de berekende verlagingen te zien in de 3D viewer kiest u in het hoofdmenu Tools - 3D
i

Viewer, klikt u op de knop in het 3D viewer venster, kiest u achtereenvolgens de
Aquifers, Wells and Heads tabjes en deselecteert u in die tabjes alles (“Clear all”). Klik dan
op de Xtra tab, zet een vinkje voor x3, kies een geschikte kleur in het palet (bijvoorbeeld
blauw) en klik op “OK”. Het resultaat zal er uitzien als Figuur 51:
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Show Tools Export Help
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|V|ew point x,y,z: -6545,-15694,71 m |Vert. exaggeration: 123 | i

Figuur 51: 3D aanzicht van verlagingen in het Xtra register
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STAP 6: INTREKGEBIED VAN DE PUT ACHTERHALEN

Het is vaak belangrijk te weten waar het door putten opgepompte grondwater geinfiltreerd is,
bijvoorbeeld om voor het betreffende gebied beschermingsmaatregelen te nemen.

In ons eenvoudige voorbeeld is met behulp van de isolijnen in Figuur 46 het intrekgebied vrij
gemakkelijk na te gaan, maar dat is lang niet altijd het geval.

Gebruik van 3-dimensionale stroomlijnen

De volgende procedure laat zien hoe met behulp van het stroomopwaarts volgen van
stroomlijnen die in de put eindigen kan worden achterhaald waar ze ter plaatse van de
grondwaterspiegel zijn gestart en hoe daarmee het intrekgebied kan worden gevonden.

Ga naar Loopmode en selecteer h1 (stijghoogte in aquifer 1). Klik op de '_"'l-knop en kies
"Next well" of het label "well", klik op de Jump-knop en sluit het dialoogvenster. Controleer
even of het huidige knooppunt inderdaad het knooppunt met de put is (bij de onttrekking
moet "8000" staan).

Ga naar Tekenmodus en klik op de E—knop of druk op F9 of kies Command - Draw
flowlines uit het hoofdmenu. Een nieuw dialoogvenster verschijnt (Figuur 52):

Drawing 3-dimensional flowlines x|

] 4
Direction : h lines A0
" Fanward Time step ] 1] Cancel
{* Backward Levels 099
Porosity (<11 [0.3 _ Help
Save file : Max time: [y) T
" Mo fiie Lichive |abel 1 vI

= Short file

% Flowline file

[~ Logarithmic timesteps
[T Stopin marked area

Filename : tutoriald #01

Figuur 52: Flowline dialoogvenster

In dit venster kan precies worden gespecificeerd hoe de stroomlijnen getekend moeten
worden. Een korte uitleg:

“Direction” (Richting): We kunnen kiezen uit “Forward” (vooruit) en “Backward” (terug), wat
hier overeenkomt met respectievelijk Stroomafwaarts en Stroomopwaarts. Omdat we de
stroomlijnen stroomopwaarts willen volgen kiezen we Backward.

“Save file” (Plotbestand): Hoewel stroomlijnen snel en makkelijk opnieuw getekend kunnen
worden is het vaak heel handig om ze op te slaan, bijvoorbeeld om ze later in een
dwarsdoorsnede te tekenen. Daarom specificeren we hier "Flowline file". MicroFEM geeft
dan een suggestie voor een bestandsnaam voor dat stroomlijnenbestand. De suggestie
"tutorial. #01" lijkt ons wel goed, maar een andere naam kan worden opgegeven indien op de
Browse-knop wordt geklikt. "Short file" is een speciaal bestandsformaat voor het maken van
responsiecurves en chemische modellering — een beetje te geavanceerd om hier te
behandelen.
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“n lines” (Aantal stroomlijnen): Hier kan het aantal stroomlijnen worden opgeven dat vanuit
het startpunt wordt getekend. Dit aantal kan alleen worden opgegeven indien er ter plaatse
een onttrekking (of injectie) is in het betreffende watervoerende pakket; in alle andere
gevallen is dit vak grijs en staat hier een "1".

“Time step” (Tijdstap): Er kunnen met regelmatige intervallen tijdstapmarkeringen worden
getekend op de stroomlijnen. In ons geval is dat niet nodig, dus voeren we hier een nul in om
aan te geven dat we geen tijdstappen willen laten tekenen.

“Levels” (Niveaus): Dit wordt alleen gevraagd als er een “thickness unit” (diktebestand) aan
het model is toegevoegd (zoals we hebben gedaan om automatisch met een freatisch
watervoerend pakket te kunnen rekenen). We kunnen hier de (relatieve) diepte waarop de
stroomlijnen moeten beginnen opgeven met een nummer tussen 0 en 1, waarbij O de top van
het watervoerend paket aangeeft en 1 de basis ervan. Als alternatief kan hier ook een geheel
getal groter dan 1 worden ingevoerd: in dat geval geeft dit getal het aantal diepteniveaus
aan, regelmatig verdeeld over de (plaatselijke) dikte van het watervoerend pakket. We
voeren hier 0.99 in om aan te geven dat het startniveau net even boven de basis van het
watervoerend pakket moet liggen.

“Porosity” (Porositeit): De effectieve porositeit van het doorstroomde medium is alleen nodig
bij het berekenen van de tijdstapmarkeringen. In MicroFEM kan alleen een porositeitswaarde
voor het gehele model worden opgegeven. In ons geval is de porositeit irrelevant, we laten
hem staan op de standaardwaarde van 0,3.

“Max. time (y)” (Maximale reistijd (jaar)): Wanneer geen maximale reistijd wordt opgegeven,
worden stroomlijnen meestal gevolgd totdat ergens een modelrand wordt bereikt (aan de
zijkant of bovenkant) of het zichtbare deel van het model wordt verlaten. In sommige
gevallen kan een stroomlijn in een put terecht komen of in een gebied met (vrijwel) geen
stroming. Wanneer hier echter wel een waarde wordt opgegeven, dan stopt de stroomlijn na
de opgegeven reistijd. Dit kan handig kan zijn voor het berekenen van bijvoorbeeld 25-
jaarszones van een onttrekking. In ons geval willen we de stroomlijnen zover mogelijk
volgen, dus laten we de standaardwaarde van nul staan (nul betekent ook hier “onbeperkt”).

“Active label” (Actief label): Bij het berekenen van stroomlijnen worden als startlocaties alle
knooppunten binnen het kaartvenster beschouwd die dezelfde labelnaam hebben als het
huidige knooppunt (van waaruit de eerste stroomlijn word getekend). Als het huidige
knooppunt geen label heeft wordt alleen vanuit dat knooppunt een stroomlijn getekend. Als
er echter meer dan één labelbestand in het model aanwezig is, kan hier worden aangegeven
welk labelbestand moet worden gebruikt voor het bepalen van de startpunten van de
stroomlijnen.

“Logaritmic time steps” (Logaritmische tijdstappen): Tijdstappen kunnen even groot zijn of
logaritmisch toenemen. Logaritmische tijdstappen kan handig zijn bij putonttrekkingen. In dit
geval tekenen we geen tijdstappen: laat dit veld blanco.

“Stop in marked area” (Stop in gemarkeerd gebied): Met markeringen kan de gebruiker
gebieden opgeven waarin geen stroomlijnen zullen worden getekend. Soms handig om te
vermijden dat het kaartvenster onoverzichtelijk wordt.

1. Nadat alle informatie in dit venster is ingevoerd, klikken we gewoon op de OK-knop en
kijken we toe bij het tekenen van de stroomlijnen. Na een tijdje ziet u het volgende beeld
(Figuur 53):
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Figuur 53: Berekende 3D-stroomlijnen vanuit de put

In dit plaatje zijn alle berekende stroomlijnen met geel getekend. Misschien hadden we wel
een andere kleur gewild, maar voor 3D-stroomlijnen gebruikt MicroFEM standaardkleuren
die ervan afhangen in welk pakket de stroomlijn zich bevindt: geel voor het bovenste
watervoerend pakket, blauw voor het tweede, groen voor het derde enz. Deze standaard-
kleuren voor 3D-stroomlijnen kunnen per laag worden aangepast (Options - Map: Color
tab) en bewaard (Options > Save settings).

In Figuur 53 kunnen we zien dat het intrekgebied van de put een vlindervorm heeft en (het
belangrijkste) dat de stortplaats erbuiten ligt. Mogelijk verontreinigd grondwater vanuit de
stortplaats vormt dus geen bedreiging voor de putonttrekking.

Tekenen van 3D-stroomlijnen in dwarsdoorsneden

Het is zeer verhelderend om de berekende stroomlijnen ook in een dwarsdoorsnede te
beschouwen. We doen dit zo:

1. Ga naar Tekenmodus, klik op de b -knop en kies een geschikte locatie voor de dwars-

doorsnede. Klik daarna op de !l—knop en de dwarsdoorsnede verschijnt dan, min of
meer zoals in Figuur 54 (voor het geval dat nog hetzelfde is als wat gebruikt werd voor
Figuur 47):

.4 MicroFEM 3.50 - tutorial3 4l 5ection ==l E3

Filez  Project “iew Commandz: Calculate  Dption

197 [ 1:1Es | 2384 |
ol 3 [o0l#el:x E 1) 7

Figuur 54: Dwarsdoorsnede met stroomlijnen (1)
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2. Het moet worden toegegeven dat de stroomlijnen in de dwarsdoorsnede niet erg
indrukwekkend overkomen, al is het maar omdat veel lijnen slechts gedeeltelijk worden
getekend. Dit komt door de nog niet aangepaste breedte van het gebied, dat wordt
begrensd door de twee evenwijdige (lichtblauwe) lijnen aan weerszijden van de profiellijn
(zie Figuur 54). Alleen die delen van het stroomlijnenbestand die binnen deze strook
vallen, worden getekend.

Om de breedte van de strook te veranderen gaat u in het hoofdmenu naar Options >
Section..., kiest u de Flowline tab en voert u een veel grotere waarde in dan standaard is
ingesteld, bijvoorbeeld 3000 m (Figuur 55: Section Options venster, flowline tab):

Section Options

Srale I I::::I::ursl Layers Flowline |

Width of flowline area |3|:||:":|

Figuur 55: Section Options venster, flowline tab

3. Zodra op de OK-knop in geklikt ziet de dwarsdoorsnede eruit als in Figuur 56:

. MicioFEM 3.50 - tutorial3 4 section M= &3

Files  Project Wiew Command: Calculate  Oplion

| 1971 | 118 | 1365 |
om i [olC|#le]s E 5 Z

Figuur 56: Dwarsdoorsnede met 3D-stroomlijnen (2)

U vraagt zich misschien af hoe het kan dat in Figuur 56 de meeste stroomlijnen duidelijk
boven de grondwaterspiegel eindigen (eigenlijk beginnen!). Wel, dat komt omdat alle delen
van de stroomlijnen die worden getekend (binnen de strook) gewoon worden geprojecteerd
op de dwarsdoorsnede. De in de dwarsdoorsnede getekende grondwaterspiegel kan best
lager liggen dan elders binnen de strook; vandaar....

3D stroomlijnen in perspectivisch aanzicht tekenen

Het is nog veel instructiever om de 3D stroomlijnen in een perspectivisch 3D aanzicht te

bekijken. Maak het 3D Viewer venster (Tools... in het hoofdmenu), klik op (Options) en
selecteer dan de Flowlines tab. Klik op “Add flowline”, selecteer in het daaropvolgende
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dialoogvenster het eerder aangemaakte stroomlijnenbestand en lees dat in. Kies dan in het
3D viewer Options venster een geschikte kleur en klik op “OK”. Met wat draaien kunt u
plaatjes maken, die lijken op Figuur 57:

-ialx]

Show  Tools Expork  Help

Ol 2| &l

|'-.-'iew poink x,v,z: 15324,-1108,15 m |'-.-'ert. exaggerakion: 74 D

M 30 Viewer =10] x|

Show Tools Export Help

52| 2| &l

‘View point x,y,2: 16672,-6351,-69 m ‘Vert. exaggeration: 103 ‘ &

Figuur 57: 3D aanzichten van stroomlijnen naar de put
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STAP 7: NIET-STATIONAIR REKENEN

Als voorbeeld voor niet-stationaire modelsimulaties zullen we het stijghoogteverloop (in de
vorm van een aantal tijd-stijghoogtelijnen) berekenen, zoals die door de putonttrekking wordt
veroorzaakt. We beginnen met de situatie zonder putonttrekking (tutorial2) die we hebben
gemaakt met de automatische optie voor freatisch rekenen (met de laagdiktes en bergings-
coéfficiénten en met het batchbestand).

1. Klik op Files = Clear in het hoofdmenu. Laad daarna het project tutorial2 (Files >
Open).

2. Plaats in Calculate > Options het vinkje bij “Phreatic top aquifer”.

3. Ga naar Invoermodus. Klik op de Stor tab in MicroFEM'’s datavenster, dan op de cel
naast de bergingscoéfficiént. Voer een waarde in van 0,2 voor alle knooppunten (F5-

toets of g—knop).
4. Ga naar Loopmodus, spring naar de put en geef een onttrekking op van 8000 m®d (q1).

We willen tijd-stijghoogtelijnen berekenen voor fictieve peilputten op een afstand van
ongeveer 200, 500, 1000 en 2000 m ten noorden van de put. Een snelle en makkelijke
manier om de afstand van geschikte knooppunten te vinden gaat als volgt:

a) Ga naar Invoermodus, klik op de Xtra-tab, hernoem rij x3 naar "r" (zonder
aanhalingstekens) en ken de waarde van variabele r toe aan alle knooppunten met
behulp van F5 (r betekent: afstand tot huidige knooppunt. We gaan ervan uit dat het
huidige knooppunt nog steeds de put is).

b) Ga naar Tekenmodus. Maak nu een isolijnenkaart van x3 met (aanvankelijk) een
interval van 200.

¢) Maak nog een isolijnenkaart van register x3 met een (iets) andere kleur en een
interval van 500.

d) Zoom in op de put (met het putknooppunt nog steeds als huidige knooppunt, gebruik

de .G_}\.l-knop) tot de binnenste isolijn nog net binnen het kaartvenster past.

e) Klik op het knooppunt dat het dichtst bij de isolijn en zo precies mogelijk noordelijk
van de put ligt, zodat dat knooppunt nu het huidige knooppunt wordt.

f) Ga naar Invoermodus. Klik op het labelveld en geef het knooppunt de naam "p200"
(zonder aanhalingstekens).

g) Zoom nu uit (gebruik de E!—knop) tot de 500-isolijn voldoende zichtbaar is. Klik op
het knooppunt dat het dichtst bij de 500-isolijn en zo precies mogelijk noordelijk van
de put ligt, zodat dat knooppunt nu het huidige knooppunt wordt.

h) Ga naar Invoermodus. Klik op het labelveld en geef het knooppunt de naam "p500"
(zonder aanhalingstekens).

i) Herhaal deze procedure ook voor knooppunten dicht bij de 1000- en 2000 m-isolijn
en noem deze knooppunten "p1000" respectievelijk "p2000".

i) Verwijder de isolijnenkaart van x3 tenslotte uit de lijst van getekende parameters
(Options - Map...).

k) Om een idee te krijgen van waar de peilputknooppunten liggen kunt u een isolijnen-
kaart laten tekenen van label 1 (MicroFEM tekent scheidingslijnen tussen naast
elkaar gelegen knooppunten met ongelijke labels).

5. We moeten nu het batchbestand aanpassen om aan te geven voor welke knooppunten

tijd-stijghoogte-informatie moet worden bewaard, bovendien moeten we ook de juiste
informatie opgeven over rekenperioden (stress periods) en tijdstappen. Kies Calculate >
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Edit batch-file in het hoofdmenu. Zorg dat het batchbestand er uit komt te zien als
hieronder:

OPEN-H p=fth

TIME DAYS=1 STEPS=3
RUN

TIME DAYS=364 STEPS=10
RUN

TIME YEARS=9 STEPS=18
RUN

END

Het OPEN-H statement dient als volgt te worden geinterpreteerd: OPEN een bestand
met de modelnaam en de extensie “fth” en schrijf hierin de tijd-stijghoogte-informatie voor
alle knooppunten met een "p" ergens in hun labelnaam. Omdat de namen van onze
peilputten alle met “p” beginnen, zal dit goed werken.

De eerste rekenperiode duurt een dag en is verdeeld in drie gelijke tijdstappen.

De tweede rekenperiode duurt een jaar min een dag, en is verdeeld in 10 stappen.

De derde en laatste rekenperiode duurt negen jaren en is verdeeld in 18 tijdstappen.

De totale simulatieperiode duurt dus 10 jaar.

Klik op de “OK”-knop om het batchbestand in het geheugen op te slaan.

6. Bewaar het gehele project nu onder een andere naam. Klik in Project - Project manager
op de bovenste unit (het Project-bestand, .fpr) om het te selecteren en klik dan op de

E!—knop, verander de naam naar tutorial3.fpr en sla het bestand op. Doe hetzelfde met
het basismodel (.fem), bewaar deze ook met de naam tutorial3. Ga door met de andere
bestanden en hernoem die alle naar tutorial3.

7. Controleer alle gegevens nog eens en als u tevreden bent, laat het model dan
doorrekenen: Calculate - Go calculate.

8. Als de isolijnenkaart opnieuw getekend wordt refereert die naar de laatst berekende
situatie, dus na 10 jaar pompen met de onttrekkingsput. Maar deze situatie is niet het
belangrijkste dat we zoeken: wat we willen zien is het tijdsafhankelijke resultaat, weer-
gegeven als de tijd-stijghoogtelijnen van de vier peilbuizen.

9. Kiik in het hoofdmenu op Tools - Time curves.... Het tijd-stijghoogtelijnenvenster

verschijnt. Klik hierin op de El-knop en selecteer tutorial3.fth in het erop volgende
bestandsmenu. Het tijd-stijghoogtelijnenvenster geeft nu de Selection tab weer die er als
volgt uitziet (Figuur 58):
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M Time-curve analysis - tutorial3. fth =]
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Figuur 58: Tijd-stijghoogtelijnenvenster, Selection tab

De opties in dit venster spreken voor zich. Laat alle tijden en knooppunten geselecteerd
en klik op de Options tab zodat een scherm als Figuur 59 zichtbaar wordt
(maak zonodig het Options venster groter (sleep een zijde) zodat het volledig te zien is):

A Time-curve analysizs - tutorial3.fth H=]

PEEE |

Selection  Options I Tirme-Head cuwel

ﬁ’ﬁlm Curve & Time - Head ¢ Distance - Head ‘ ¥ Head scale
Head scale * linear ' logarithmic ‘ ¥ Time scals
. v L label
Time scale + linear " logarithmic ‘ ol Brpzleet
[+ Horizontal grid
Huorizortal seale—————— Vertical scale———————
B [+ “ertical grid
Min ID Mir ID
-l_ [ MNodes in prafile
b 1] [LET a
B ackgraund CU|°TI 1 'l Interval: |0 Interval: |0
Axes color I ] 'l W Automatic scals ¥ Automatic scals

Figuur 59: Tijd-stijghoogtelijnenvenster, Options tab

10. Zoals gebruikelijk in deze beginnershandleiding willen we een witte achtergrond en
zwarte assen, dus stellen we dit zo in via het kleuren-dropdown menu linksonder.
Vervolgens klikken we op het kleurenpalet links op een blauw vierkantje zodat we meer
contrast zien op de witte achtergrond
Nu moeten we nog opgeven wat we precies getekend willen hebben. Voorlopig zijn de
standaardwaarden wel goed. Ter completering voegen we horizontale en verticale
rasterlijnen (“grid”) toe en zetten we ook een vinkje bij de "Nodes as labels"-optie (zodat
labelnamen in plaats van knooppuntnummers worden getoond in de grafiek).

11. Tenslotte klikken we op de Time-Head curve tab om de grafiek te zien (Figuur 60):
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Figuur 60: Time-Head curve
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EPILOOG

Dit is het einde van de MicroFEM beginnershandleiding. We hopen dat u er plezier van heeft
gehad en dat u nu genoeg weet van werken met MicroFEM om uw eerste echte
modelproject te kunnen draaien. Er zijn nog heel veel opties en mogelijkheden onbesproken
gebleven, zoals stroomvectoren, full-color grafieken, fluxfuncties, niet-stationaire
waterbalansen, nog afgezien van alle Invoer- en Uitvoerfuncties en bestandsformaten.
Probeer deze zelf uit en maak daarbij goed gebruik van de On-line Help om gedetailleerde
informatie over de mogelijkheden van MicroFEM na te zoeken.
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